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1 Fonctionnement du système - Introduction

Tankvision Professional est une application fiable et évolutive de gestion du stock en cuve, adaptée 

aussi bien pour des petits terminaux ou dépôts de carburant que pour de grandes raffineries.

Le système peut être fourni sur une station autonome à utilisateur unique ou comme système multi-

utilisateur configuré comme une architecture client-serveur. Il utilise une base de données 

relationnelle ouverte standard.

Tankvision Professional est un appareil indépendant qui peut être configuré pour jouer le rôle 

d'interface avec n'importe quel appareil de fournisseur. Il existe actuellement une large gamme de 

pilotes de communication et d'interfaces et d'autres sont en cours de développement.

Le présent manuel est conçu comme une aide pour l'utilisation du software.
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2 La page d'accueil

Lorsque Tankvision Professional est lancé à partir du menu Start ou de son raccourci sur le bureau, 

la page d'accueil est chargée.

Chaque cuve configurée dans le système a sa propre fenêtre graphique.

La page d'accueil dispose d'une barre de menu, d'une barre d'outils, d'un espace de travail de 

l'application et d'une barre d'état au bas de la fenêtre. 

Le système démarre avec la page d'accueil maximisée et toutes les fenêtres de cuve ouvertes.

BA00396G_0001

L'accès aux fonctions fréquemment utilisées se fait normalement à partir de la barre d'outils. 

Les fonctions moins fréquemment utilisées sont accessibles via la barre de menu.

2.1 La vue des cuves

C'est la vue individuelle par défaut pour chaque cuve dans la page d'accueil. Voir la figure suivante 

pour exemple.

BA00396G_0002

L'apparence générale et la taille de chaque fenêtre sont fixes. Les fenêtres ne peuvent pas être mises 

à l'échelle. Lorsque plusieurs fenêtres sont ouvertes, elles sont réparties en mosaïque sur la surface 

disponible dans la fenêtre de la page d'accueil. S'il y a plus de fenêtres ouvertes que de place 

disponible, des barres de défilement apparaîtront automatiquement en bas à droite de la fenêtre 

mère.

La fenêtre a été équipée d'un certain nombre de raccourcis vers d'autres caractéristiques d'affichage, 

et d'un menu contextuel sensible pour un accès rapide à d'autres caractéristiques.
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2.2 La fenêtre de base de la vue des cuves

La fenêtre montre :

• Le numéro de la cuve

• Une représentation graphique de la cuve indiquant le type de cuve, par ex. toit conique, toit 

flottant, etc.

• Le produit affecté à la cuve

• Un bargraph montrant le niveau dans la cuve

• Une sélection de champs de données numériques pouvant être configurés par l'utilisateur. 

• Si une alarme est actuellement active pour la cuve 

• Si les données numériques sont en mode manuel ou automatique le cas échéant

• L'état de mouvement de la cuve, c'est-à-dire statique, remplissage, vidange

• L'état de connexion du jaugeur, c'est-à-dire connecté, déconnecté, en cours de connexion, 

en cours de déconnexion

! Remarque ! 

Si l'état de connexion est tout sauf "Connected", dans ce cas, TOUTES les données de la cuve datent 

de la dernière connexion et ne sont par conséquent PAS ACTUELLES.

2.2.1 Affichage des données en mode manuel

Les valeurs de données en mode manuel sont représentées en bleu sur fond noir.

La fenêtre suivante indique que la température du produit est en mode manuel.

Les données donc mises à jour en utilisant la fonction Manual Data Entry. Pour plus de détails, voir 

le chapitre concernant la Manual Data Entry.

BA00396G_0003

2.2.2 Raccourci vers Manual Data Entry

Lorsqu'une valeur numérique est en mode manuel, l'utilisateur peut accéder rapidement à 

l'affichage des données manuelles en double-cliquant sur l'élément de données manuelles. 

Cela lancera le module Manual Data Entry.

2.2.3 Raccourci vers Single Tank Overview

Si vous double-cliquez sur la fenêtre de la cuve, la vue Single Tank Overview est lancée pour cette 

cuve.

Pour une description complète, voir le chapitre Single Tank Overview. L'accès à Single Tank 

Overview est également disponible à partir de la barre d'outils.
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2.2.4 Cuve sous alarme

Lorsqu'une cuve a une alarme active, une icône d'alarme apparaît sur la cuve.

BA00396G_0004

De plus, une étiquette abrégée est placée sous l'icône pour indiquer le type d'alarme. Si plusieurs 

alarmes sont actives, c'est l'alarme avec la priorité la plus élevée qui est affichée. Sur l'illustration, 

GL H correspond à Gauge Level High (alarme niveau jaugeur haut).

Pour une description complète, voir le chapitre sur les alarmes.

2.2.5 Identifier l'alarme qui s'est produite

Lorsqu'une alarme se produit, un événement est généré, une icône apparaît sur la cuve, un 

avertissement sonore est émis, et un message vocal optionnel peut être émis.

Une fois toutes ces actions réalisées, la seule preuve restante de l'alarme est l'icône. Par ailleurs,

le résumé des alarmes actives montrera également toutes les alarmes actives.

Pour plus d'informations sur les alarmes actives, double-cliquez sur l'icône d'alarme.

Le module Alarm Summary sera chargé. Voir illustration ci-dessous.

BA00396G_0005

Le module Alarm Summary montre toutes les alarmes actives. Une alarme active aura sa case 

cochée.
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2.2.6 Identifier les cuves en mouvement

La fenêtre Tank View identifie les cuves en mouvement de différentes manières :

• En affichant un indicateur de direction de remplissage, c'est-à-dire une flèche vers le haut ou vers 

le bas selon la direction du mouvement.

• Par l'amplitude et le signe du débit par exemple, un débit positif représente le remplissage, un 

débit négatif la vidange.

• Finalement, selon la configuration, la couleur du produit dans la cuve peut être utilisée pour 

représenter l'état de mouvement. Par exemple, le bleu représente le remplissage, le brun la 

vidange et le vert la stabilité. Voir la section Réglages du système pour savoir comment activer 

cette fonction.

L'illustration ci-dessous montre une cuve en mouvement. 

BA00396G_0006

Le débit est négatif et l'indicateur de direction de remplissage pointe vers le bas.
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2.2.7 Etat de connexion

L'état de connexion de la cuve est affiché sur le côté droit.

BA00396G_0007

C'est l'un des états suivants :

• Connected

• Disconnecting

• Disconnected

• Connecting

L'état Connected (connecté) signifie que les appareils externes, par ex. les jaugeurs sont interrogés 

en continu. Pour les connexions par modem, les données ne peuvent être demandées que 

périodiquement.

Si l'état de connexion est tout sauf Connected, dans ce cas, TOUTES les données de la cuve datent 

de la dernière connexion et ne sont par conséquent PAS ACTUELLES.

BA00396G_0008

Dans l'image écran ci-dessus, la cuve est en état Disconnected mais conserve les données de sa 

dernière connexion. Par conséquent, les données ne doivent PAS être considérées comme à jour.
Endress+Hauser 9



La page d'accueil Tankvision Professional NXA85 - Fonctionnement du système
2.3 Options du menu contextuel

Un menu contextuel est disponible. Cliquez sur le bouton droit de la souris dans une des fenêtres 

Tank View et le menu contextuel apparaîtra.

Voir l'illustration ci-dessous pour exemple.

BA00396G_0009

Certaines des options dans le menu contextuel dépendent de la configuration de la cuve. Cela sera 

abordé plus loin dans ce chapitre.

2.3.1 Manual Data

L'option de menu Manual mode possède un sous-menu contenant toutes les options disponibles 

pour le mode manuel. Cette option est utilisée pour commuter les valeurs du mode manuel au mode 

automatique.

Les valeurs en mode manuel sont mises en évidence par une coche.

2.3.2 Alarm Enable

Si cette option de menu est visible, elle mène à un sous-menu qui indique si l'alarme est activée ou 

désactivée. Une coche apparaîtra à côté de l'option de menu pour indiquer que cet élément de 

données est activé.

2.3.3 Movements

Si cette option de menu est visible et activée, elle permet d'accéder facilement aux mouvements de 

produit de la cuve. La sélection d'un mouvement listé dans le sous-menu montrera les détails de ce 

mouvement.
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2.3.4 Gauge Commands

L'option de menu Gauge commands possède un sous-menu contenant toutes les commandes de 

jaugeurs disponibles dans ce contexte.

Voir l'illustration ci-dessous.

BA00396G_0010

Les commandes disponibles sont expliquées et décrites ci-dessous.

Servo Check

Réaliser un test de répétabilité sur un appareil de jaugeage servo. Cette commande tentera de 

monter le displacer d'au moins 300 mm et de le redescendre au niveau du produit. Le niveau avant 

l'élévation du capteur est comparé au niveau après le retour du capteur à la surface du produit. Si 

les deux sont dans la tolérance définie, la fonction Servo check est considérée comme réussie.

Cette commande n'est disponible que pour les appareils de jaugeage servo.

Stow

Fixe le capteur du jaugeur en position verrouillée ou en position d'arrêt supérieure. Cette 

commande n'est disponible que pour les appareils de jaugeage servo.

Unstow

Annule la commande Stow et repositionne le capteur au niveau du produit. Peut aussi être utilisé 

pour annuler toute commande actuellement en cours.

Freeze

Bloque le displacer à son niveau actuel.

Unfreeze

Déverrouille la dernière commande Freeze et permet au displacer de retourner au niveau du 

produit.
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Water Scan

Lorsque cette option est sélectionnée, le jaugeur tentera de trouver l'interface eau et retournera au 

niveau du produit. Notez que cette commande ne fonctionne que si votre jaugeur prend en charge 

la fonction Water scan.

Density Scan

Lorsque cette option est sélectionnée, le jaugeur effectuera un balayage du profil de densité et 

retournera à la densité moyenne observée. Notez que cette commande ne fonctionne que si votre 

jaugeur prend en charge le profil de densité.

Scan Mode

Off Scan, Normal Scan et Fast Scan sont des options qui s'excluent mutuellement et qui contrôlent 

la fréquence avec laquelle le jaugeur est scanné.

• Off Scan

Le jaugeur n'est pas interrogé

• Normal Scan

Le jaugeur est interrogé à intervalles normaux

• Fast Scan

Le jaugeur est interrogé à chaque interrogation (c'est-à-dire plus fréquemment), au détriment des 

autres jaugeurs.

• Manual Scan

Utilisé lorsque le jaugeur est Off Scan, pour qu'il soit interrogé une fois

Connection Status

Connect, Disconnect, Connect Once sont des options qui s'excluent mutuellement et qui 

déterminent l'état de connexion du port interface auquel la cuve est raccordée. Par conséquent, si 

l'une de ces commandes est envoyée à une cuve, elle s'appliquera alors à TOUTES les cuves 

raccordées au même port COM ou modem sur le PC.

• Connect

L'interface se connecte au port COM ou modem et continue d'interroger les jaugeurs 

indéfiniment ou jusqu'à ce qu'une commande de déconnexion soit envoyée par l'utilisateur.

• Disconnect

L'interface se déconnecte du port COM ou du modem et reste déconnectée.

• Connect Once

L'interface se connecte au port COM ou au modem et se déconnecte automatiquement lorsqu'elle 

a récupéré toutes les données des jaugeurs.
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3 Single Tank Overview

La vue Single Tank Overview donne un aperçu détaillé de toutes les données d'une cuve unique.

Elle peut être lancée : 

• En double-cliquant sur une fenêtre Tank View

• En cliquant sur le bouton Single Tank Overview de la barre d'outils

Une fois le module Single Tank Overview chargé, d'autres cuves peuvent être visualisées en les 

sélectionnant dans la liste déroulante.

Les données affichées sont organisées en groupes logiques ; Primary Gauging data, Flow Rates, 

Inventory Data et Alarm Settings.

Les valeurs de données en mode manuel sont affichées en vert sur fond noir.

Les données indisponibles pour n'importe quelle raison seront remplacées par un numéro de 

diagnostic.

Voir l'illustration ci-dessous pour un exemple typique.

BA00396G_0011

Les infobulles donnent des informations sur chacun des champs de données.

Pour une description détaillée et la définition de chacun des champs, voir le chapitre Définitions.
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3.1 Cuve sous alarme

Si la cuve sélectionnée a une alarme active, une icône d'alarme s'affiche sur la cuve. Le détail des 

alarmes activées peut être déterminé en double-cliquant sur l'icône d'alarme pour lancer l'Alarm 

Summary Display.

Dans le récapitulatif des alarmes, une coche apparaît à côté de chaque alarme active.

Voir l'illustration ci-dessous.

BA00396G_0012
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3.2 Visualiser les températures

Certains jaugeurs sont capables de mesurer des points multiples à partir de capteurs de température 

spéciaux. 

! Remarque ! 

Les profils de température ne peuvent être visualisés que si 

a. Le système a été configuré pour interroger les températures. Pour cela, assurez-vous que 

Average Temp. Fitted est coché pour le jaugeur dans l'écran Gauge Configuration.

b. Le sous-système Trending est configuré pour suivre la tendance des éléments de température 

pour ce jaugeur. Cela se fait dans l'écran Trending Configuration.

Pour plus de détails sur les options ci-dessus, voir le manuel de configuration.

3.2.1 Afficher le profil de température

Pour afficher l'écran Temperature Profile, cliquez sur  dans l'écran Single Tank Overview.

L'affichage suivant est typique :

BA00396G_0013
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3.2.2 Format d'affichage graphique

Les données peuvent être affichées dans un format graphique à l'aide de l'onglet Graph. Dans cette 

vue, des détails supplémentaires du profil sont également montrés, comme la valeur moyenne, etc.

Configurer le format d'affichage

L'affichage graphique peut être configuré à l'aide des options de menu suivantes :

• View -> Average Temperature

Cochez cette option pour afficher la température moyenne.

• View -> Data Points

Cochez cette option pour visualiser les points de données individuels sur le graphe.

• View -> Data Labels

Cochez cette option pour visualiser les valeurs de données individuelles sur le graphe.

• Tools -> Options

Une boîte de dialogue s'affiche, dans laquelle on peut régler les couleurs utilisées pour les 

différentes lignes sur le graphe.

• Tools -> Configure Element Levels

Une boîte de dialogue s'affiche, dans laquelle on peut entrer la hauteur des éléments de 

température. Cela sera utile lors du tracé du graphe, à la place du numéro des éléments.

Plage d’affichage

Par défaut, la température sur le graphe est mise à l'échelle en utilisant les valeurs minimum et 

maximum du tableau. Cela peut toutefois donner quelquefois un affichage trompeur. La plage peut 

être réglée manuellement en cochant l'option Enable Temperature Min/Max et en entrant la 

gamme min. et max.

Mémoriser le graphe

Le graphe peut être mémorisé en format bitmap en sélectionnant File -> Save Graph ...

3.2.3 Format d'affichage tabulaire

Les données peuvent également être visualisées sous forme de tableau en cliquant sur l'onglet Data.

BA00396G_0014

Le tableau des températures peut être imprimé ou prévisualisé en sélectionnant File -> Print et 

File -> Print Preview.
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3.3 Visualiser les données de profil

Certains jaugeurs sont capables de réaliser un profil de densité/température (ou uniquement la 

densité pour certains jaugeurs) dans tout le produit.

Ces données sont alors retournées sous la forme d'un tableau des densités et des températures (si 

pris en charge) et mémorisées dans la base de données.

Les données de profil peuvent ensuite être visualisées sous forme de graphique ou de tableau.

Il y a deux écrans pour la visualisation des données de profil :

• Single Profile Viewer

Un seul profil peut être affiché à la fois.

• Profile Viewer

jusqu'à 6 profils peuvent être affichés en même temps.

Les deux écrans s'ouvrent à partir de l'écran Single Tank Overview.
Endress+Hauser 17
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4 Se connecter

L'accès aux caractéristiques du système peut être contrôlé via un compte utilisateur. L'obligation de 

se connecter au système peut être désactivée, ce qui donne à tous les utilisateurs un accès total au 

système. Si la sécurité est activée, les sections suivantes s'appliquent.

4.1 Se connecter à Tankvision Professional

1. Sélectionnez Security>Log In... dans la barre de menu principale.

2. Une invite à se connecter apparaîtra.

3. Entrez le nom d'utilisateur et le mot de passe nécessaires.

Les détails sont vérifiés par rapport aux entrées dans la base de données. Si le nom d'utilisateur 

et le mot de passe sont valables, l'utilisateur est connecté à son niveau d'accès désigné.

4. Lorsqu'un utilisateur est connecté au système, son nom d'utilisateur est affiché à la gauche de 

la barre d'état.

! Remarque ! 

Chaque compte utilisateur a un niveau d'accès désigné à chaque fonction. Ce qui signifie que même 

si un utilisateur est connecté, il n'a pas forcément accès à toutes les fonctions. Le niveau d'accès 

d'un utilisateur est déterminé par les droits qui lui ont été assignés par l'administrateur de système.

4.2 Se déconnecter de Tankvision Professional

Sélectionnez l'option Security>Log Out dans la barre de menu principale.

Le système déconnecte immédiatement l'utilisateur actuellement connecté.

Cela empêche l'accès à toutes les fonctions nécessitant une connexion.
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4.3 Configurer de nouveaux comptes utilisateur

Pour plus d'informations, voir le chapitre Configuration de la sécurité du manuel Administrateurs 

de système.

! Remarque ! 

Les droits d'accès à de nouveaux utilisateurs doivent être donnés après mûre réflexion. Le niveau 

d'accès le plus élevé ne doit pas être donné à tous les utilisateurs. C'est à l'administrateur du système 

de déterminer qui a quels droits.

Nous recommandons de ne donner aux utilisateurs occasionnels que le minimum de droits pour 

commencer.

Il est toujours possible de les ajuster ultérieurement si les utilisateurs deviennent des utilisateurs 

habituels du système.
Endress+Hauser 19



Alarmes et événements Tankvision Professional NXA85 - Fonctionnement du système
5 Alarmes et événements

Les alarmes et événements sont affichés sur l'écran Alarm Event Viewer disponible en permanence.

5.1 Que se passe-t-il si une alarme se produit

• Une icône d'alarme est affichée sur la cuve dans la fenêtre Tank View, voir ci-dessous.

• La description de l'état d'alarme dans Grid View et Single Tank Overview change pour montrer 

l'alarme avec la plus haute priorité.

• Un événement est généré par le système et affiché dans l'écran Alarm Event Viewer.

• Un signal sonore, s'il est activé, est généré. Il peut avoir la forme d'un avertisseur interne ou 

externe ou d'une carte son selon l'équipement. Un message vocal peut être émis via la carte son 

du PC si cette option a été activée.

• Les alarmes deviennent silencieuses une fois acquittées. Si la sécurité est activée, les utilisateurs 

doivent se connecter avec les privilèges appropriés pour acquitter l'alarme.

• Les alarmes et événements sont tous consignés dans la base de données. Un historique des 

alarmes peut être utilisé pour visualiser toutes les alarmes et tous les événements qui se sont 

produits.

• Lorsqu'une alarme est acquittée, la date et l'heure sont consignées dans la base de données. 

L'utilisateur connecté qui acquitte l'alarme est également consigné.
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5.2 Acquitter des alarmes

L'Alarm Event Viewer affiche les détails des alarmes de la façon suivante :

BA00396G_0020

5.2.1 Etat des alarmes

L'état de l'alarme est indiqué dans la colonne la plus à gauche et la plus à droite :

• Rouge

Non acquittée et non silencieuse. Pour une alarme "Active" (voir 5.3.4 Options de notification), 

cela clignotera.

• Bleu clair

Silencieuse mais pas acquittée.

• Vert

Acquittée.
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5.2.2 Couper et acquitter les alarmes

Pour couper ou acquitter une alarme, il est nécessaire de la sélectionner en cliquant sur la ligne avec 

la souris. Une fois l'alarme sélectionnée (indiqué par un fond bleu), elle peut être coupée ou 

acquittée. Si la sécurité est activée, il est nécessaire d'être connecté pour couper ou acquitter une 

alarme.

Acquitter une alarme

1. L'alarme sélectionnée peut être acquittée en cliquant sur le bouton Acknowledge Alarm 

( ) ou en utilisant le raccourci clavier (voir 5.3.4 Options de notification)

2. Si l'alarme sélectionnée a été configurée pour exiger un motif d'acquittement, l'écran des 

motifs d'acquittement s'affiche :

3. Le bouton OK n'est disponible qu'une fois le motif entré. L'alarme ne peut être acquittée qu'en 

cliquant sur le bouton OK.

Couper une alarme

L'alarme sélectionnée peut être coupée en cliquant sur le bouton Silence Alarm ( ) ou en 

utilisant le raccourci clavier (voir 5.3.4 Options de notification).

Acquitter ou couper des alarmes multiples

Il est également possible d'acquitter ou de couper une alarme unique ou des alarmes multiples en 

cliquant sur la liste des alarmes avec le bouton droit de la souris. Cela ouvre le menu des options :

BA00396G_0022

Si l'une des alarmes non acquittées requiert un motif d'acquittement, le message suivant s'affichera 

lorsque vous essaierez d'acquitter toutes les alarmes :

BA00396G_0023

Toutes les alarmes exigeant un motif d'acquittement doivent être acquittées individuellement avant 

que les alarmes non acquittées restantes puissent être acquittées avec Acknowledge all.
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5.3 Event History Viewer

L'Event History Viewer peut être lancé soit en cliquant sur le bouton correspondant dans la barre 

d'outils de la page d'accueil soit en sélectionnant View>Events dans le menu de l'Alarm Event 

Viewer.

BA00396G_0024

Par défaut, tous les événements du jour en cours sont affichés. Les événements affichés peuvent être 

filtrés par date ou appareil dans l'ordre croissant, par date d'acquittement ou utilisateur. Pour les 

clients connectés à des serveurs multiples, il est également possible de spécifier le serveur à partir 

duquel les événements doivent être pris. Ces réglages sont mémorisés à la fermeture de l'Event 

History Viewer et utilisés par défaut au prochain lancement de l'Event History Viewer.

Le visualiseur d'événements affiche également les détails d'actions auditables. Il est possible de 

filtrer si les événements et/ou actions auditées sont affichés à l'aide des boutons  et . 

Pour plus de détails sur les actions auditées, double-cliquez dessus. Cela ouvre un écran détaillant 

les modifications :

BA00396G_0025
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6 Rapports

Un jeu standard de rapports de tank gauging et de stock est proposé.

Pour accéder aux rapports, procédez de la façon suivante :

1. Choisissez File>Reports dans le menu principal "Home Page".

2. Sélectionnez le type de rapport à imprimer :

– Group Selection

Rapport pour un groupe de cuves défini par l'utilisateur.

– Product Selection

Rapport récapitulant toutes les cuves contenant un produit particulier (par ex. Jet A1).

– Standard Inventory Report

Montre une sélection standard des données de stock pour toutes les cuves.

– Standard Summary Report

Récapitule le stock de produits pour toutes les cuves par produit.

– Gauge Configuration

Rapport montrant les données principales de configuration des jaugeurs.

– Tank Configuration

Rapport montrant les données principales de configuration des cuves.

– Custom Print

Permet de sélectionner un rapport produit par un tiers, à exécuter par le système de tank 

gauging. Vous pouvez sélectionner un fichier RPT à partir de l'entrée Custom dans 

l'arborescence des rapports.

3. Cliquez sur le bouton Next.

4. Sélectionnez les dimensions du rapport à imprimer.

5. Cliquez sur le bouton Next.

6. Sélectionnez Print ou Preview

– Preview

Affiche une copie du rapport sélectionné à l'écran.

– Print

Imprime le rapport sur votre imprimante Windows par défaut.
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7 Grille

GridView est une vue tabulaire des données des cuves.

L'application GridView est personnalisable et comprend un menu contextuel pour envoyer les 

commandes de jaugeurs usuelles.

L'utilisateur peut créer ses propres vues de données et les combiner à des fonctions standard de 

regroupement des cuves pour personnaliser totalement la présentation des données.

Pour lancer GridView, cliquez sur le bouton approprié dans la barre d'outils.

7.1 Lancer le module Grid View

Cliquez sur le bouton GridView dans la barre d'outils ou lancez l'application GridView.exe à partir 

du dossier cible.

L'illustration ci-dessous est typique.

BA00396G_0027
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7.2 Sélectionner les vues des données

Grid View s'ouvre par défaut avec plusieurs vues de données prédéfinies.

Les vues de données disponibles sont listées dans la liste déroulante sur la barre d'outils.

Voir l'illustration ci-dessous pour information.

BA00396G_0028

Les vues fixes sont :

• Tank Gauging

• Tank Inventory 

• Gauge Status 

Chaque vue contient différentes colonnes d'informations.

Toutes les autres vues listées sont des vues définies par l'utilisateur.

D'autres vues peuvent être configurées par l'utilisateur.

7.3 Sélectionner les groupes de cuves

Par défaut, le module GridView affiche toutes les cuves.

Grid View permet à l'utilisateur de choisir l'un des groupes de cuves préconfigurés pour afficher 

uniquement les cuves apparaissant dans ce groupe de cuves.

Les groupes de données disponibles sont listés dans la liste déroulante sur la barre d'outils.

Voir l'illustration ci-dessous pour information.

BA00396G_0029

Si aucun groupe n'a été configuré, la liste sera vide en dehors du groupe All Tanks fixé.
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7.4 Trouver une cuve spécifique

GridView permet à l'utilisateur de trouver une cuve dans la liste des cuves. Si l'identité de la cuve 

est connue, vous pouvez l'entrer directement dans le champ prévu à cet effet ; les lignes de la grille 

défilent jusqu'à ce que la cuve sélectionnée soit trouvée. En alternative, la cuve peut être 

sélectionnée dans la liste déroulante et, de même, la grille défile pour afficher la cuve sélectionnée.

7.5 Cuves sous alarme

Un certain nombre de boutons de la barre d'outils permettent de récapituler rapidement les cuves 

ayant une alarme active.

BA00396G_0030

7.6 Configurer une nouvelle vue de données

1. Déroulez le menu Options.

2. Sélectionnez l'option Maintain Views....

L'écran Maintain Views s'affiche :

3. Pour créer une nouvelle vue, cliquez sur le bouton New. Pour éditer la vue sélectionnée, 

cliquez sur le bouton Edit. Dans tous les cas, l'écran Maintain View s'affiche :
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4. Pour une nouvelle vue, le nom de la vue est vierge mais doit être entré avant de pouvoir 

mémoriser la vue.

5. La liste sur la gauche est la liste des champs disponibles pour être ajoutés à la vue. 

La liste peut être triée 

– par type ( )

– alphabétiquement ( )

– non triée ( )

6. Pour ajouter un champ à la vue, sélectionnez-le et cliquez sur le bouton Add ( ) ou double-

cliquez dessus.

Pour ajouter tous les champs d'un type donné à la vue, sélectionnez n'importe quel champ de 

ce type et cliquez sur le bouton Add all ( ).

7. La liste sur la droite est la liste des champs actuellement dans la vue. 

Pour supprimer un champ de la vue, sélectionnez-le et cliquez sur le bouton Remove ( ) ou 

double-cliquez dessus.

Pour supprimer tous les champs de la vue, cliquez sur le bouton Remove all ( ).

8. Pour sauvegarder les changements et quitter, cliquez sur le bouton OK. 

Pour quitter sans sauvegarder les changements, cliquez sur le bouton Cancel.

9. Pour effacer une vue, sélectionnez-la et cliquez sur le bouton Delete. La vue sélectionnée sera 

effacée.

10. Pour quitter l'écran Maintain Views, cliquez sur le bouton Close.

11. Déroulez la liste des vues dans la barre d'outils de l'application GridView.

La nouvelle vue doit être dans la liste.
28 Endress+Hauser



Tankvision Professional NXA85 - Fonctionnement du système Grille
7.7 Couleur du débit

Lorsqu'il y a une colonne Flow Rate dans la vue, la ligne affichant une cuve en mouvement se colore 

soit en brun soit en bleu. Les lignes brunes indiquent que le niveau dans la cuve baisse, les lignes 

bleues que le niveau monte. La couleur de fond reste inchangée pour les cuves statiques.

BA00396G_00034

La grille conserve trois valeurs seuils configurables par l'utilisateur pour déterminer quand une ligne 

doit changer de couleur. Les valeurs seuils sont utilisées selon que la vue montre un niveau, un débit 

massique ou volumique.

Pour configurer les valeurs seuils, sélectionnez Options > Set Flow Rate Colour Thresholds... 

dans le menu. La boîte de dialogue Flow Rate Threshold s'affiche.

BA00396G_0035

Si l'un des champs de données dépasse la consigne, la ligne deviendra brune ou bleue selon la 

direction du mouvement.

Vous ne pouvez pas régler les seuils sur zéro.

La valeur seuil du niveau dans la vue grille est indépendante du seuil similaire configuré pour la page 

d'accueil.
Endress+Hauser 29



Grille Tankvision Professional NXA85 - Fonctionnement du système
7.8 Impression et aperçu avant impression

Le contenu actuel de la grille peut être envoyé à une imprimante ou prévisualisé à l'écran.

7.8.1 Imprimer une grille

Pour imprimer le contenu d'une grille, sélectionnez File>Print.. dans le menu ou appuyez sur le 

bouton d'impression de la barre d'outils. 

Si l'option de menu est utilisée, il est possible de modifier l'imprimante et les réglages de 

l'imprimante à utiliser pour imprimer la grille. 

Si vous utilisez le bouton de la barre d'outils, le contenu actuel de la grille est imprimé sur 

l'imprimante par défaut.

7.8.2 Prévisualiser une grille

Pour imprimer une prévisualisation, sélectionnez File>Print Preview dans le menu ou appuyez 

sur le bouton de prévisualisation de la barre d'outils. Un écran identique à celui ci-dessous s'affiche.

BA00396G_0036
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8 Commandes de jaugeurs

Les commandes de jaugeurs peuvent être spécifiques au jaugeur et dépendent, par conséquent, du 

type de jaugeur.

Par exemple, les jaugeurs Enraf prennent en charge les fonctions suivantes :

• Dipping

Propose différents modes de mesure d'interface, tels que Find Water Interface, Find Product 

Interface et Density Dipping.

• Displacement

Propose des fonctions de commande du displacer.

• Test Gauge Alarm

Permet de réaliser l'auto-test des consignes d'alarme du jaugeur radar 873.

• Maintenance

Permet de régler le niveau de référence du jaugeur.

• Gauge Items

Outil général permettant de lire ou d'écrire n'importe quelle option de jaugeur et de visualiser les 

données retournées et/ou les réponses.

Les autres jaugeurs peuvent prendre en charge d'autres fonctions de commande et de configuration.

8.1 Lancer des commandes de jaugeurs

1. Déroulez le menu Tools, sélectionnez l'option Gauge Command.

2. L'application sélectionne automatiquement le jaugeur principal de la cuve si la cuve a plus d'un 

jaugeur. L'utilisateur peut par la suite sélectionner un autre jaugeur en cliquant sur le "+" à côté 

de la cuve, ainsi que la tâche du jaugeur.
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8.2 Envoyer une commande

1. Sélectionnez la cuve dans une liste sur le panneau de gauche. Développez la cuve avec le 

symbole "+" (sélectionnez le jaugeur en mode multi-jaugeur).

Les commandes prises en charge par le jaugeur sont activées.

2. Sélectionnez la commande appropriée dans la liste.

3. Réglez les paramètres requis et cliquez sur le bouton d'action (Execute, Dip, etc.).

En général, la réaction et l'état de la commande sont retournés à l'utilisateur via le panneau au 

bas de la fenêtre.
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8.2.1 Fonctions de jaugeage

BA00396G_0040

Elles s'appliquent généralement à la série Enraf 854 de jaugeurs servo.

Product Measurement Mode

• Envoie l'option I1.

• Affiche l'état du jaugeur.

• Le jaugeur reste à I1 jusqu'à ce que l'utilisateur émette une autre commande.

Density Dip 

Cette fonction a deux options :

• Tank Profile

• Interface Profile

Sélectionnez la bonne option et cliquez sur le bouton Apply.

La commande sera exécutée.

Water Measurement Mode 

• Envoie l'option I3.

• Affiche l'état du jaugeur.

• Le jaugeur reste à I3 jusqu'à ce que l'utilisateur émette une autre commande.
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8.2.2 Fonctions du displacer

Lock

BA00396G_0041

• Verrouille le displacer à un niveau donné.

• Utilise l'option MZ pour régler le niveau de verrouillage, suivi de la commande LT.

• L'utilisateur doit indiquer le niveau auquel le displacer sera verrouillé.

• Le jaugeur restera en position verrouillée jusqu'à ce que l'utilisateur lui donne un contre-ordre.
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Verify Calibration

BA00396G_0042

• Vérifie l'étalonnage de l'appareil. Le displacer monte jusque dans la chambre d'étalonnage du 

jaugeur.

• Utilise l'option CA.

• Le jaugeur restera en mode étalonnage jusqu'à ce que l'utilisateur lui donne un contre-ordre.

• Mémorise et affiche le niveau initial.

• Affiche les différents changements d'état qui se sont produits.

• Appuyez sur le bouton Unlock pour que le displacer retourne en mode Product Measurement.

Unlock

• Déverrouille le jaugeur de la position verrouillée ou de la position d'étalonnage.

• Envoie l'option UN.
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8.2.3 Maintenance

BA00396G_0043

Règle le jaugeur à un nouveau relevé de niveau.

Si le jaugeur diffère du jaugeage manuel de l'utilisateur, il faut réaligner le jaugeur au jaugeage de 

l'utilisateur.

L'utilisateur doit fournir le nouveau relevé de niveau et le mot de passe pour accéder au jaugeur.

Cette fonction utilise toute une séquence d'options de jaugeur :

• Règle le niveau de mot de passe à l'aide de l'option de jaugeur W2.

• Règle le niveau de référence à l'aide de l'option de jaugeur RL.

• Accepte le niveau de référence à l'aide de l'option de jaugeur AR.

• Quitte et réinitialise le jaugeur à l'aide de l'option de jaugeur EX.

La procédure :

1. Sélectionnez la cuve nécessitant un nouveau relevé de niveau.

2. Entrez le nouveau niveau du jaugeur.

3. Appuyez sur le bouton Dip.

La séquence d'actions ci-dessus se déroule.

L'état de chaque transition doit être affiché.

! Remarque ! 

Lorsque la commande EX est émise à la fin, les données du jaugeur peuvent disparaître pendant un 

court instant pendant que le jaugeur se réinitialise automatiquement. Après réinitialisation, le 

niveau du jaugeur doit afficher une nouvelle valeur.
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8.2.4 Eléments de jaugeage

BA00396G_0044

! Remarque ! 

Cette fonction ne s'applique qu'aux jaugeurs Enraf et Motherwell.

" Attention ! 

L'utilisation de cette fonction requiert une bonne connaissance du dispositif de jaugeage, et il est 

recommandé que seul du personnel compétent utilise cette fonction.

Cette fonction permet à l'utilisateur de lire/écrire n'importe laquelle des options de configuration 

des jaugeurs. Pour lire une option, entrez dans l'option et cliquez sur Apply, la réponse s'affichera. 

Pour écrire une option, entrez dans l'option et entrez les données que vous souhaitez écrire, puis 

cliquez sur Apply. 

Options des jaugeurs Enraf

Conversion des unités

Cet onglet permet la conversion des unités affichées dans Tankvision Professional dans les unités 

configurées pour le jaugeur. Pour éviter toute confusion, nous recommandons de modifier les unités 

affichées pour qu'elles correspondent à celles utilisées par le jaugeur, si cela est possible. De cette 

manière, le format utilisé pour les réglages effectués via un terminal portable Enraf (PET) 

correspondra directement avec le format à utiliser dans l'onglet Gauge Items.

Lire une requête

Pour lire une requête, il n'y a pas de données à fournir. Les données seront converties dans les unités 

système actuelles avant d'être affichées.

Format des données

Lors du réglage des options, l'utilisateur doit entrer les données dans le format exact approprié pour 

les dimensions/unités sélectionnées, avec le signe +/- et le nombre approprié de chiffres avant et 

après la virgule. Si vous n'êtes pas sûr du format, lisez la valeur actuelle de l'option désirée en 

laissant dans un premier temps le champ "vide". La valeur réponse du jaugeur s'affiche dans le 

format approprié dans les dimensions/unités en vigueur. Utilisez ensuite le même format que la 

réponse retournée pour régler l'option à la nouvelle valeur désirée. Un signe égal "=" doit précéder 

la valeur lorsque vous réglez les options.
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Liste des dimensions/unités prises en charge

Touche :

• ± signe (+/-)

• N chiffre

• . signe décimal

! Remarque ! 

Toutes les autres options utilisent des formats fixés qui ne sont pas touchés par les dimensions/

unités sélectionnées par l'utilisateur. Pour plus de détails, voir la documentation du fabricant du 

jaugeur.

Niveau

Unités Format

mm ± N N N N N N . N (par défaut)

m ± N N N . N N N N

ft ± N N N N . N N N

in ± N N N N N . N N

f-i-s ± N N ' N N " N N

Température

Unités Format

°C ± N N N . N N (par défaut)

°F ± N N N . N N

Densité

Unités Format

kg/l ± N N . N N N N N (par défaut)

kg/m³ ± N N N N N . N N

lb/ft³ ± N N N . N N N N

°API ± N N N N . N N N

Pression

Unités Format

bar ± N N . N N N N N (par défaut)

Pa ± N N N N N N . N

kPa ± N N N N . N N N

lb/in² ± N N N . N N N N
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Options des jaugeurs Motherwell

Les options des jaugeurs Motherwell ne disposent pas de la même fonction de conversion des unités. 

Les données entrées dans le champ Gauge Item sont transmises mot pour mot au jaugeur. Pour 

déterminer le format précis des données, consultez la documentation Motherwell.

Avec les jaugeurs Motherwell, vous pouvez soit spécifier le code option hexadécimal à 2 chiffres, 

comme décrit dans la documentation du jaugeur Motherwell, soit utiliser un code abrégé pour 

certaines options de données.

Code abrégé Description

UR Upper Reference Level (niveau de référence 
supérieur)

RL Reference Level (niveau de référence)

HH High High Alarm Level (niveau d'alarme haut haut)

HA High Alarm Level (niveau d'alarme haut)

LA Low Alarm Level (niveau d'alarme bas)

LL Low Low Alarm Level (niveau d'alarme bas bas)
Endress+Hauser 39



Regroupement de cuves Tankvision Professional NXA85 - Fonctionnement du système
9 Regroupement de cuves

Le système propose toute une série d'outils et de fonctions pour organiser et regrouper les cuves 

selon les exigences de l'utilisateur.

Toutes les fonctions de regroupement de cuves sont généralement disponibles à partir du module 

Tank Grouping.

Le regroupement est en général organisé en groupes statiques et groupes dynamiques.

• Les groupes statiques peuvent s'organiser par :

– Produit

– Groupe de produits

– Groupe de cuves défini par l'utilisateur

• Les groupes dynamiques sont automatiques selon les critères définis.

L'affichage du module Tank Grouping comprend une boîte de dialogue à plusieurs onglets. 

Chaque onglet représente l'un des modes de regroupement des cuves.

L'accès à certaines fonctions de regroupement des cuves est protégé par un mot de passe. Vous serez 

invité à vous connecter le cas échéant.

9.1 Configurer et utiliser un groupe statique

1. Chargez le module Tank Grouping en cliquant sur Quick View>Tank Groups dans la barre 

de menu des groupes.

2. Cliquez sur l'onglet Static Groups.

3. Appuyez sur le bouton Add.... L'écran des groupes statiques s'affiche :
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4. Entrez le nom du groupe, puis cliquez sur les cuves disponibles pour les ajouter ou les 

supprimer du groupe. Toutes les cuves en surbrillance font partie du groupe. Pour sauvegarder 

le groupe, cliquez sur le bouton OK. Pour quitter et perdre les modifications, cliquez sur le 

bouton Cancel.

5. Pour sauvegarder les changements pour tous les groupes, cliquez sur le bouton OK. Pour 

quitter et perdre toutes les modifications, cliquez sur le bouton Cancel.

Le groupe statique peut à présent être utilisé en le sélectionnant dans le menu Static Groups 

de la barre de menu.

9.1.1 Editer un groupe statique existant

1. Chargez le module Tank Grouping en cliquant sur Quick View>Tank Groups dans la barre 

de menu des groupes.

2. Cliquez sur l'onglet Static Groups.

3. Sélectionnez le groupe à modifier et appuyez sur le bouton Edit... L'écran des groupes 

statiques s'affiche :

4. Cliquez sur les cuves disponibles pour les ajouter ou les supprimer du groupe. Toutes les cuves 

en surbrillance font partie du groupe.

5. Pour sauvegarder le groupe, cliquez sur le bouton OK. Pour quitter et perdre les modifications, 

cliquez sur le bouton Cancel.

6. Pour sauvegarder les changements pour tous les groupes, cliquez sur le bouton OK. 

Pour quitter et perdre toutes les modifications, cliquez sur le bouton Cancel.

Le groupe statique peut à présent être utilisé en le sélectionnant dans le menu Static Groups 

de la barre de menu.

9.1.2 Effacer un groupe statique existant

1. Chargez le module Tank Grouping en cliquant sur Quick View>Tank Groups dans la barre 

de menu des groupes.

2. Cliquez sur l'onglet Static Groups.

3. Sélectionnez le groupe de cuves à effacer de la liste des groupes.

4. Appuyez sur le bouton Delete.
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9.2 Regroupement de produits

Le système permet de visualiser des cuves contenant un produit particulier.

9.2.1 Utiliser un groupe de produits

1. Chargez le module Tank Grouping en sélectionnant Quick View > Tank Groups.

2. Cliquez sur l'onglet Product Groups.

La liste des produits disponibles s'affiche :

! Remarque ! 

S'il y a un grand nombre de produits, vous pouvez utiliser les barres de défilement pour trouver 

le produit que vous cherchez.

3. Sélectionnez le produit souhaité dans la liste.

Les cuves contenant actuellement ce produit sont listées.

4. Le groupe de produits peut être utilisé en le sélectionnant dans le menu Product Groups dans 

la barre de menu.

9.2.2 Fenêtre Product Total

La fenêtre Product Total ne s'affiche que lorsque la fonction Product Grouping est utilisée.

La fenêtre Product Total affiche des sommes de volumes pour le produit sélectionné.

Les éventuelles autres cuves qui n'ont pas pu être incluses dans le total à cause d'une erreur ou d'un 

défaut sont listées.

Pour plus de détails, voir l'illustration ci-dessous.

BA00396G_0049
42 Endress+Hauser



Tankvision Professional NXA85 - Fonctionnement du système Regroupement de cuves
9.3 Regroupement dynamique

Le système propose une fonction de base de regroupement dynamique qui permet de visualiser des 

cuves remplissant certains critères dynamiques, par ex. cuves en mouvement.

Lorsqu'un groupe dynamique est utilisé, dès que les cuves ne remplissent plus les critères, elles sont 

automatiquement retirées de l'affichage.

Le nombre de groupes dynamiques disponibles est fixe.

Ces groupes sont définis automatiquement par le système.

9.3.1 Utiliser un groupe dynamique

1. Chargez le module Tank Grouping en cliquant sur le bouton approprié de la barre d'outils.

2. Cliquez sur l'onglet Dynamic Groups.

La liste des groupes dynamiques disponibles s'affiche :

3. Sélectionnez un groupe dynamique.

Les cuves remplissant les critères pour le groupe dynamique spécifié s'affichent. Par exemple, 

Moving Tanks concerne toutes les cuves en mouvement quelle que soit la direction, Receipt 

tanks toutes les cuves actuellement en cours de remplissage.
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9.4 Régler les cuves à surveiller

1. Chargez le module Tank Grouping en sélectionnant Quick View > Tank Groups. 

Sélectionnez l'onglet Quick View.

2. Sélectionnez les cuves souhaitées en cliquant dessus.

A la première sélection, la cuve apparaîtra sur fond bleu.

A la sélection suivante, elle sera désélectionnée.

! Remarque ! 

– Pour sélectionner simultanément toutes les cuves, appuyez sur le bouton Select All puis sur 

OK pour afficher toutes les cuves.

– Pour désélectionner simultanément toutes les cuves, appuyez sur le bouton Deselect All 

puis sur OK pour réduire toutes les cuves.

3. Appuyez sur le bouton OK pour afficher les cuves sélectionnées.
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10 Aide et diagnostic

Le système contient une aide détaillée et une fonction de diagnostic.

La plus grande partie de l'aide apparaît dans le menu Help de la page d'accueil.

Les options disponibles dans le menu Help sont détaillées dans les sections suivantes.

10.1 Diagnostic

Pour voir la signification des codes de diagnostic (numéros DN) qui apparaissent sur l'affichage de 

la cuve, double-cliquez dessus pour lancer le module Diagnostic Codes.

10.1.1 Lancer le module Diagnostics

Sélectionnez l'option Diagnostics dans le menu Help dans la barre de menu de la page d'accueil.

Le type d'affichage suivant est chargé :

BA00396G_0052

La première colonne liste les codes de diagnostic, la deuxième contient une brève définition et la 

dernière colonne contient le nom d'un fichier qui contient plus de détails sur les causes potentielles 

du diagnostic et l'action recommandée pour identifier et résoudre le problème associé. La sous-

fenêtre de droite affiche le contenu du fichier.
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10.1.2 Prévisualiser la liste de diagnostic 

Sélectionnez l'option Print Preview > Diagnostics List dans le menu File.

Le type d'affichage suivant est chargé :

BA00396G_0053

Appuyez sur l'icône d'impression pour envoyer le rapport à l'imprimante Windows par défaut.

10.1.3 Lancer le ficher d'actions recommandées

Pour plus d'informations sur le code de diagnostic, double-cliquez sur la ligne en question.

Le bloc-notes Windows est lancé et ouvre le fichier des actions recommandées.

Voir l'illustration ci-dessous pour un exemple typique.

BA00396G_0054
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10.2 Versions

Le menu Help dans la barre de menu de la page d'accueil contient une option appelée Versions.

Si vous sélectionnez cette option de menu, un module d'affichage est lancé et montre les versions 

de chacun des modules de l'application. Il donne également la date de modification de chaque 

module.

Ces informations sont utiles en cas d'appel à l'assistance technique de votre fournisseur.

L'une des premières questions en cas d'appel sera inévitablement quelle version du module est 

installée.

Il est possible d'imprimer la liste complète des modules et de leurs versions correspondantes et dates 

de modification.

10.2.1 Lancer le module Versions

Sélectionnez l'option Versions dans le menu Help dans la barre de menu de la page d'accueil.

Le type d'affichage suivant est chargé :

BA00396G_0055

Utilisez les barres de défilement pour voir les détails de chaque fichier listé. 
Endress+Hauser 47



Aide et diagnostic Tankvision Professional NXA85 - Fonctionnement du système
10.2.2 Prévisualiser un rapport des versions de module

Sélectionnez l'option Print Preview dans le menu File.

Le type d'affichage suivant est chargé :

BA00396G_0056

Appuyez sur l'icône d'impression pour envoyer le rapport à l'imprimante Windows par défaut.
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10.3 About

Le menu Help dans la barre de menu de la page d'accueil contient une option appelée About.

Lorsqu'elle est sélectionnée, cette option de menu charge un module d'affichage montrant la version 

générale de votre application, les détails de la licence et la personne/société pour laquelle 

l'application Tankvision Professional est enregistrée, ainsi qu'une indication sur les droits d'auteur.

Ces informations sont utiles en cas d'appel à l'assistance technique de votre fournisseur.

L'une des premières questions en cas d'appel sera inévitablement qui est l'utilisateur enregistré et le 

numéro de licence/version de l'application.

10.3.1 Lancer le module About

Sélectionnez l'option About dans le menu Help dans la barre de menu de la page d'accueil.

Le type d'affichage suivant est chargé :

BA00396G_0057

Appuyez sur le bouton OK décharger le module.
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11 Tendance

Caractéristiques clés

• Jusqu'à six affichages simultanés sur un seul graphe 

• Axes indépendants pour chaque variable de process 

• Grille d'affichage pour une meilleure lecture

• Curseur de données pour lire les valeurs de tendance

• Prend en charge des multi-dimensions dynamiques

• Zoom avant sur des données avec la fonction Zoom

• Défilement vers l'arrière et vers l'avant

• Extension de l'axe Y configurable par l'utilisateur

• Base de temps programmable par l'utilisateur

11.1 Suivi des tendances et enregistrement des données

Le système est équipé en standard d'un pack de suivi des tendances complet. Un dispositif 

d'enregistrement des tendances consigne les données de tendance sur le disque dur du système.

Il y a deux interfaces utilisateur pour afficher les données de tendance :

• Tendance en temps réel

• Tendance historique

11.2 Tendance en temps réel

La fonction de tendance en temps réel combine la possibilité de remonter jusqu'aux 12 dernières 

heures des données de tendance historique avec les données en temps réel actuelles.

11.2.1 Lancer une tendance en temps réel

Cliquez sur le bouton Real-Time Trending de la barre d'outils.

L'affichage de la tendance en temps réel est chargé.

Il est chargé avec les dernières données complétant le dernier filtre temps réel entré. Au début, 

il est vide.

11.2.2 Configurer l'affichage de la tendance en temps réel

1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tendance 

en temps réel.

Le module de filtre de la tendance en temps réel est chargé.

Voir l'illustration ci-dessous pour un exemple typique.
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! Remarque ! 

Le champ du serveur n'est visible que pour les systèmes redondants. Pour les systèmes 

redondants, le champ du serveur peut être réglé sur Automatic pour récupérer le serveur actuel 

en service ou sur un serveur spécifique.

– Interval

Il s'agit de l'intervalle pour lequel les données de tendance doivent être visualisées à l'heure 

équivalant à la quantité de données historiques à afficher avec les nouvelles données en 

temps réel. Les données de temps réel sont ajoutées à l'historique.

– Plot Interval

Il s'agit de l'intervalle de temps entre les points le long de l'axe X. Notez que si Interval est 

réglé sur une longue période et Plot Interval sur un intervalle court, le chargement des 

données de tendance peut prendre du temps.

– Trend Fields

Jusqu'à six champs peuvent être affichés. Si le mode de sélection actuel permet de 

sélectionner une heure sur le graphe de tendance, seuls cinq champs sont disponibles.

2. Sélectionnez une cuve dans la liste déroulante.

3. Sélectionnez la variable de process pour la cuve pour laquelle on souhaite suivre la tendance.

4. Les valeurs maximum et minimum optionnelles pour l'axe y peuvent également être entrées 

si nécessaire. Plus la gamme est petite entre les valeurs minimum et maximum, plus il y a de 

détails affichés. Pour entrer des valeurs maximum et minimum, il est nécessaire de 

désélectionner l'entrée Auto-Scale pour le champ.

5. Cliquez sur le bouton OK.

L'affichage de tendance est configuré pour afficher les données requises.

Le chargement de la partie historique des données peut prendre un petit peu de temps. Cela 

dépendra du nombre d'heures spécifié, du nombre de tendances et de l'emplacement des 

fichiers de tendance.

Voir l'illustration ci-dessous pour un exemple de données de tendance.
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11.2.3 Utiliser l'affichage de la vue de tendance en temps réel

Une fois la configuration de la tendance terminée et l'affichage de la vue de tendance configuré, 

l'affichage des données de tendance en temps réel commence immédiatement.

La tendance défile de la droite vers la gauche. Le côté droit étant l'heure actuelle.

Les nouvelles données sont ajoutées du côté droit de l'affichage.

Le nombre de variables de process sélectionnées détermine le nombre d'axes Y représentés sur la 

vue, et, par conséquent, le nombre de tendances affichées.

Chaque tendance est affichée dans une couleur unique.

11.2.4 Trouver une valeur sur une tendance

Les valeurs des variables de process à un point donné dans le temps peuvent être déterminées si le 

mode de sélection du graphe n'est pas None. Pour changer le mode de sélection du graphe, cliquez 

n'importe où sur le graphe avec le bouton droit de la souris. A partir du menu affiché, sélectionnez 

Selection Mode puis le mode de sélection requis. C'est l'une des valeurs suivantes :

• None

Il n'est pas possible de sélectionner une heure sur le graphe et la valeur des variables de process 

n'est pas affichée.

• Fixed Time

Une heure peut être sélectionnée sur le graphe et les variables de process correspondantes sont 

affichées sur la gauche de l'affichage. Etant donné que de nouvelles valeurs sont ajoutées sur le 

graphe, la ligne indiquant la sélection défile vers la gauche, en restant à la même heure.

• Fixed Location

Une heure peut être sélectionnée sur le graphe et les variables de process correspondantes sont 

affichées sur la gauche de l'affichage. Etant donné que de nouvelles valeurs sont ajoutées sur le 

graphe, la ligne indiquant la sélection reste à la même place avec les variables de process défilant 

après.

Si le Selection Mode n'est pas None, la sélection actuelle peut être déplacée vers l'arrière et vers 

l'avant dans le temps à l'aide des flèches gauche et droite. Pour un déplacement plus rapide, 

maintenez la touche Shift enfoncée tout en utilisant les flèches gauche et droite.

11.2.5 Zoom avant pour plus de détails

Le module de tendance permet à l'utilisateur de zoomer dans les données de tendance et les 

tendances plus en détails.

1. Si le mode de sélection actuel n'est pas None, il est nécessaire de mettre le graphe en mode 

zoom en cliquant sur le bouton Zoom de la barre d'outils.

2. Identifiez la zone de la tendance sur laquelle vous voulez plus de détails.

3. A l'aide de la souris, tracez un cadre autour de la zone en question en cliquant avec le bouton 

gauche de la souris. Tout en maintenant le bouton gauche de la souris enfoncé, déplacez le 

pointeur de la souris vers la droite ou la gauche et vous verrez apparaître un cadre pouvant être 

redimensionné. Elargissez le cadre autour de la zone en question et relâchez le bouton de la 

souris.

4. Le système fera un zoom avant sur la zone sélectionnée. Une barre de défilement horizontale 

apparaît et vous permet de vous déplacer vers l'arrière et vers l'avant dans les données au 

niveau de zoom actuel.

5. Si nécessaire, vous pouvez zoomer encore plus en utilisant la même technique.

6. Pour quitter le mode Zoom et retourner au mode de sélection, cliquez à nouveau sur le bouton 

Zoom de la barre d'outils.

Il est à présent possible de sélectionner une heure sur le graphe en cliquant dessus au lieu 

d'identifier une zone sur laquelle zoomer.
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11.2.6 Zoom arrière vers la vue par défaut

Vous pouvez effectuer un zoom arrière vers la vue par défaut de la façon suivante :

1. Cliquez sur le bouton droit de la souris n'importe où sur le graphe de tendance.

Un menu déroulant apparaît.

2. Sélectionnez l'option Undo Zoom.
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11.3 Tendance historique

La fonction de tendance historique permet à l'utilisateur de visualiser des données de tendance 

historique entre une date de début et de fin.

11.3.1 Lancer une tendance historique

Cliquez sur le bouton Historical trending de la barre d'outils. Il est chargé avec les dernières données 

complétant le dernier filtre historique entré. Au début, il est vide.

11.3.2 Configurer l'affichage de la tendance historique

1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tendance 

historique. Le module de filtre de la tendance historique est chargé.

Voir l'illustration ci-dessous pour un exemple typique.

! Remarque ! 

Le champ du serveur n'est visible que pour les systèmes redondants. Pour les systèmes 

redondants, le champ du serveur peut être réglé sur Automatic pour récupérer le serveur 

actuel en service ou sur un serveur spécifique.

– Interval

Il s'agit de l'intervalle pour lequel les données de tendance doivent être visualisées à l'heure 

équivalant à la quantité de données historiques à afficher avec les nouvelles données en 

temps réel. Les données de temps réel sont ajoutées à l'historique.

– Date/Time Start

Il s'agit de la date/heure de départ pour laquelle les données de tendance historiques doivent 

être affichées.

– Date/Time End

Il s'agit de la date/heure de fin pour laquelle les données de tendance historiques doivent 

être affichées.

– Plot Interval

Il s'agit de l'intervalle de temps entre les points le long de l'axe X. Notez que si la durée entre 

Date/Time Start et Date/Time End est longue et Plot Interval est réglé sur un intervalle 

court, le chargement des données de tendance peut prendre du temps.

– Trend Fields

Jusqu'à six champs peuvent être configurés pour afficher soit des informations en direct soit 

des informations calculées sous forme de tendance. Si le mode de sélection actuel permet de 

sélectionner une heure sur le graphe de tendance, seuls cinq champs peuvent être 

configurés.

2. Sélectionnez une cuve dans la liste déroulante.
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3. Sélectionnez la variable de process pour la cuve pour laquelle on souhaite suivre la tendance.

4. Les valeurs maximum et minimum optionnelles pour l'axe y peuvent également être entrées 

si nécessaire. Plus la gamme est petite entre les valeurs minimum et maximum, plus il y a de 

détails affichés. Pour entrer des valeurs maximum et minimum, il est nécessaire de 

désélectionner l'entrée Auto-Scale pour le champ.

5. Cliquez sur le bouton OK.

L'affichage de tendance est configuré pour afficher les données requises. Le chargement des 

données historiques peut prendre un petit peu de temps. Cela dépendra de la longueur de 

temps spécifiée, du nombre de tendances et de l'emplacement des fichiers de tendance.

Voir l'illustration ci-dessous pour un exemple de données de tendance.

11.3.3 Utiliser l'affichage de la vue de tendance historique

L'affichage des données de la tendance historique prend en charge la fonction de zoom, ce qui permet 

d'avoir un aperçu des données de tendance puis de zoomer sur les détails pour une analyse plus fine.

Le nombre de variables de process sélectionnées détermine le nombre d'axes Y représentés sur la 

vue, et, par conséquent, le nombre de tendances affichées.

Chaque tendance est affichée dans une couleur unique.

11.3.4 Trouver une valeur sur une tendance

Les valeurs des variables de process à un point donné dans le temps peuvent être déterminées si le 

mode de sélection du graphe n'est pas None. Pour changer le mode de sélection du graphe, cliquez 

n'importe où sur le graphe avec le bouton droit de la souris. A partir du menu affiché, sélectionnez 

Selection Mode puis le mode de sélection requis. C'est l'une des valeurs suivantes :

• None

Il n'est pas possible de sélectionner une heure sur le graphe et la valeur des variables de process 

n'est pas affichée.

• Fixed Time

Une heure peut être sélectionnée sur le graphe et les variables de process correspondantes sont 

affichées sur la gauche de l'affichage. Etant donné que de nouvelles valeurs sont ajoutées sur le 

graphe, la ligne indiquant la sélection défile vers la gauche, en restant à la même heure.

• Fixed Location

Une heure peut être sélectionnée sur le graphe et les variables de process correspondantes sont 

affichées sur la gauche de l'affichage. Etant donné que de nouvelles valeurs sont ajoutées sur le 

graphe, la ligne indiquant la sélection reste à la même place avec les variables de process défilant 

après.

Si le Selection Mode n'est pas None, la sélection actuelle peut être déplacée vers l'arrière et vers 

l'avant dans le temps à l'aide des flèches gauche et droite. Pour un déplacement plus rapide, 

maintenez la touche Shift enfoncée tout en utilisant les flèches gauche et droite.
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11.3.5 Zoom avant pour plus de détails

Le module de tendance permet à l'utilisateur de zoomer dans les données de tendance et les 

tendances plus en détails.

1. Si le mode de sélection actuel n'est pas None, il est nécessaire de mettre le graphe en mode 

zoom en cliquant sur le bouton Zoom de la barre d'outils.

2. Identifiez la zone de la tendance sur laquelle vous voulez plus de détails.

3. A l'aide de la souris, tracez un cadre autour de la zone en question en cliquant avec le bouton 

gauche de la souris. Tout en maintenant le bouton gauche de la souris enfoncé, déplacez le 

pointeur de la souris vers la droite ou la gauche et vous verrez apparaître un cadre pouvant être 

redimensionné. Elargissez le cadre autour de la zone en question et relâchez le bouton de la 

souris.

4. Le système fera un zoom avant sur la zone sélectionnée. Une barre de défilement horizontale 

apparaît et vous permet de vous déplacer vers l'arrière et vers l'avant dans les données au 

niveau de zoom actuel.

5. Si nécessaire, vous pouvez zoomer encore plus en utilisant la même technique.

6. Pour quitter le mode Zoom et retourner au mode de sélection, cliquez à nouveau sur le bouton 

Zoom de la barre d'outils. Il est à présent possible de sélectionner une heure sur le graphe en 

cliquant dessus au lieu d'identifier une zone sur laquelle zoomer.

11.3.6 Zoom arrière vers la vue par défaut

Vous pouvez effectuer un zoom arrière vers la vue par défaut de la façon suivante :

1. Cliquez sur le bouton droit de la souris n'importe où sur le graphe de tendance.

Un menu déroulant apparaît.

2. Sélectionnez l'option Undo Zoom.
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11.4 Tendance historique (tableau)

La fonction Historical Trending (Table) permet à l'utilisateur de visualiser des données de tendance 

historique sur une période pour laquelle il existe des données.

11.4.1 Lancer la tendance historique (tableau)

Cliquez sur le bouton Historical trending (Table) de la barre d'outils.

L'affichage Historical Trend (Table) est chargé. Il est chargé avec les dernières données complétant 

le dernier filtre historique entré. Au début, il est vide.

11.4.2 Configurer l'affichage de la tendance historique (tableau)

1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tendance 

historique (tableau).

Le module de filtre de la tendance historique est chargé.

Voir l'illustration ci-dessous pour un exemple typique.

! Remarque ! 

Le champ du serveur n'est visible que pour les systèmes redondants. Pour les systèmes 

redondants, le champ du serveur peut être réglé sur Automatic pour récupérer le serveur actuel 

en service ou sur un serveur spécifique.

– Date/Time Start

Il s'agit de la date/heure de départ pour laquelle les données de tendance historiques doivent 

être affichées.

– Date/Time End

Il s'agit de la date/heure de fin pour laquelle les données de tendance historiques doivent 

être affichées.

– Fields

Sélectionnez une cuve dans la liste déroulante. Sélectionnez les variables de process pour la 

cuve pour laquelle on souhaite suivre la tendance.
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– Values

Sélectionnez le mode d'affichage des données :

– Logged Values Only

Etant donné que le dispositif d'enregistrement des tendances ne consigne que les 

modifications apportées aux données, il est possible que tous les enregistrements de 

données ne contiennent pas des données pour toutes les variables de process 

sélectionnées. Si cette option est sélectionnée, toute variable de process qui n'a pas de 

valeur entrée dans l'enregistrement de données reste vide.

– All Implied Values

Si cette option est sélectionnée, toute variable de process qui n'a pas de valeur entrée dans 

l'enregistrement de données prend la valeur contenue dans le précédent enregistrement.

– Interpolated Values

Si cette option est sélectionnée, un enregistrement des données est généré pour chaque 

intervalle de temps donné entre la date/heure de départ et la date/heure de fin. Les 

valeurs des variables de process sont déduites de l'enregistrement de données actuel 

précédent immédiatement la date/heure sur l'enregistrement généré.

2. Effectuez les réglages nécessaires et cliquez sur le bouton OK.

L'affichage de tendance est configuré pour afficher les données requises.

Le chargement des données historiques peut prendre un petit peu de temps. Cela dépendra de 

la longueur de temps spécifiée, du nombre de champs et de l'emplacement des fichiers de 

tendance.

Voir l'illustration ci-dessous pour un exemple de données de tendance.
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11.4.3 Exporter les données de tendance

Le module Historical Trending (Table) est utilisé pour exporter les données de tendance sous forme 

de fichier CSV. Une fois un filtre réglé pour Historical Trending (Table) et un tableau de données de 

tendance affiché, sélectionnez File > Export.... L'écran suivant s'affiche :

BA00396G_0067

Il s'agit en principe d'un dialogue de fichier Windows standard avec les champs supplémentaires 

suivants :

• Export Headers

Si cette option est sélectionnée, le premier enregistrement de données dans le fichier exporté 

contiendra les en-têtes du tableau au lieu des données.

• Data Format

Cette option contrôle le mode de formatage des données.

– Formatted Data

Exporter des données de tendance sous forme de données formatées signifie que le contenu du 

fichier CSV correspondra exactement aux données affichées dans le tableau (Notez toutefois 

que si le fichier CSV est ouvert à l'aide de Microsoft Excel, l'application pourra reformater les 

données avant de les afficher).

– Raw Data in Base Units

Exporter les données de tendance sous forme de données brutes dans les unités de base signifie 

que le fichier CSV contiendra des données brutes provenant du fichier des données de 

tendance. Cela signifie que le formatage des informations (comme le nombre de places 

décimales) et la conversion des valeurs (comme l'état d'alarme) ne seront pas exportés et le 

fichier CSV ne contiendra que des données numériques.

– Raw Data

Exporter des données de tendance sous forme de données brutes est identique à l'option 

précédente hormis le fait que les champs contenant les données qui peuvent être affichées dans 

des unités différentes (comme les niveaux, les températures, etc) verront leurs valeurs 

converties à l'aide des unités actuellement sélectionnées pour ce type de champ.
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12 Calculateur de stocks

Le système est équipé en standard d'un calculateur de stock.

L'objectif premier du calculateur de stock est de donner à l'utilisateur un moyen de calculer le stock 

en cuve pour des conditions qui n'existent actuellement pas.

Par exemple, il pourrait être utilisé comme un calculateur "que se passe-t-il si". Si une cuve doit être 

chargée ou déchargée de X litres de produit, quelles seront les conditions finales de la cuve.

Il peut être utilisé comme un simple outil de planification avant le chargement et/ou le 

déchargement du produit. 

12.1 Lancer l'application Inventory Calculator

Appuyez sur le bouton Inventory Calculator de la barre d'outils.

Le module Inventory Calculator est chargé. Voir l'illustration ci-dessous pour un exemple typique. 

L'Inventory Calculator est un affichage multi-onglet comprenant le calculateur de cuve direct, le 

calculateur de mouvement chargement/déchargement, un convertisseur d'unités de mesure et un 

calculateur d'interpolation linéaire.

BA00396G_0068
60 Endress+Hauser



Tankvision Professional NXA85 - Fonctionnement du système Calculateur de stocks
12.2 Tank Calculator

Le Tank Calculator permet à l'utilisateur de calculer le stock en cuve à des conditions spécifiées par 

l'utilisateur.

12.2.1 Visualiser les données de cuve actuelles

Sélectionnez une cuve dans la liste déroulante.

Les données actuelles de tank gauging et de stock sont affichées pour la cuve sélectionnée avec le 

tableau API actuellement configuré pour la cuve.

12.2.2 Entrer les critères définis par l'utilisateur

L'utilisateur peut entrer les données suivantes :

• Product Level  

• Product Temperature  

• Product Density 

• Water Level  

• Pressure

• Molecular Mass 

• Temperature Coefficient 

• Density Correction Factor 

• API Table 

Certains champs de données ne sont pas toujours valables pour le tableau API sélectionné.

Les champs pouvant être édités sont clairement marqués sur l'affichage en fond blanc.

La procédure

Pour calculer les données, procédez de la façon suivante :

1. Modifiez l'un des champs éditables.

2. Appuyez sur le bouton Calculate.

Les paramètres de stock sont recalculés pour les nouvelles données.

! Remarque ! 

Les données configurables par l'utilisateur sont validées avant d'effectuer les calculs.

Par exemple, si le niveau dépasse la plage de service de la cuve, un avertissement est généré dans 

la barre d'état ainsi qu'un avertissement sonore. La description de l'avertissement doit être suffisante 

pour déterminer l'erreur. Dans la plupart des cas, la limite maximum ou minimum est affichée le 

cas échéant.

Exemple

Par exemple, pour visualiser le stock en cuve à un niveau de produit différent, effacez simplement 

ou écrasez la valeur de niveau actuelle avec la nouvelle et appuyez sur le bouton Calculate.
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12.3 Movement Calculator

Le Movement Calculator permet à l'utilisateur de simuler un chargement ou un déchargement de 

produit dans ou de la cuve.

BA00396G_0069

1. Avant d'entrer les détails du mouvement, sélectionnez une cuve dans la liste. Les conditions 

actuelles des cuves sont affichées.

2. Spécifiez le mouvement comme :

– un changement de niveau direct

– un déchargement/chargement en volume

– un déchargement/chargement en masse

3. Spécifiez s'il s'agit d'un déchargement (mouvement out) ou d'un chargement (mouvement in) 

pour pouvoir calculer les conditions finales correctement.

4. Entrez la quantité à décharger ou à charger.

5. Par ailleurs, vous pouvez activer jusqu'à quatre Target Pre Alarms en cochant l'alarme 

appropriée. Vous devez ensuite entrer une valeur d'offset relative au niveau final de sorte que 

lorsque vous appuyez sur le bouton Calculate, un niveau de consigne d'alarme absolu est 

calculé automatiquement.

6. Appuyez sur le bouton Calculate pour voir les valeurs finales des cuves.

7. Vous pouvez sauvegarder les données calculées dans la base de données en cliquant sur le 

bouton Set Values. 

Cela détermine le niveau de mouvement final de sorte que le système de tank gauging puisse 

calculer le temps nécessaire pour atteindre cette cible, sur la base du débit actuel. Les 

préalarmes de cible sont également réglées et activées.

8. Les calculs peuvent être effacés en cliquant sur le bouton Clear Values. Les préalarmes de 

cible sont également effacées.
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12.3.1 Exemple : Simuler un chargement de produit

1. Sélectionnez la cuve réceptrice dans la liste.

2. Cliquez sur bouton Receipt.

3. Sélectionnez l'option appropriée pour Measurement, à savoir by Volume, Weight of Level.

Par exemple, supposons que nous allons recevoir un volume connu d'un pipeline. Sélectionnez 

l'option Volume.

4. Entrez la Quantity comme volume à recevoir.

Les unités utilisées pour le volume sont celles définies dans le module Change Dimensions.

Supposons que les unités de volume réglées sont les litres.

5. Activez les préalarmes cibles et entrez l'offset du niveau final auquel elles doivent se 

déclencher.

6. Appuyez sur le bouton Calculate.

Résultat

• L'Inventory Calculator va aux données de Tank Calibration pour la cuve sélectionnée et 

détermine le changement de niveau pour le volume donné. Le changement de niveau s'appliquera 

aux conditions actuelles des cuves pour déterminer les conditions finales.

• Par conséquent, le niveau calculé et les données de stock seront les conditions attendues une fois 

le mouvement de produit terminé.

• Le calcul des conditions finales est vérifié par rapport aux limites de fonctionnement de la cuve 

et, si l'une des limites de travail est dépassée, une erreur se produit et l'utilisateur est averti par 

un message détaillé.

• Pour toutes les préalarmes activées, la consigne de niveau absolu à laquelle l'alarme se 

déclenchera est calculée et affichée. La consigne est calculée en appliquant l'offset entré pour le 

niveau cible final.
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12.4 Interpolation

L'onglet Interpolation est un outil très simple de calcul d'interpolation linéaire. Il permet à 

l'utilisateur d'entrer des données directement à partir d'un groupe de tables d'étalonnage et de 

calculer le volume à un niveau inconnu par une simple interpolation linéaire.

BA00396G_0070

12.5 Conversion des unités

L'onglet Unit Conversion contient un outil simple permettant de convertir une valeur dans une 

unité de mesure en une valeur correspondante dans d'autres unités. Sélectionnez le type de valeurs 

dans les options sur la gauche. L'utilisateur peut alors sélectionner dans la liste déroulante les unités 

de mesure de la valeur initiale et sa valeur numérique, puis sélectionner une autre unité de mesure 

dans laquelle la valeur doit être convertie. Cliquez sur le bouton Calculate pour effectuer la 

conversion.

BA00396G_0071
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13 Scan Controller

L'état d'interrogation des jaugeurs peut être réglé à l'aide de l'outil Scan Controller. Pour accéder au 

Scan Controller, sélectionnez Tools>Scan Controller dans le menu principal de la page d'accueil.

BA00396G_0072

Les détails de tous les jaugeurs configurés dans la base de données sont affichés avec l'état 

d'interrogation actuel (Scan Status).

A partir de cette page, il est possible de régler l'état d'interrogation d'un ou plusieurs jaugeurs.

Sélectionner les jaugeurs

• Pour sélectionner un jaugeur, cliquez dessus dans le tableau.

• Pour sélectionnez plusieurs jaugeurs, maintenez la touche Control enfoncée et cliquez sur le bloc 

en début de ligne pour le jaugeur suivant.

• En alternative, cliquez sur le bouton Select All pour sélectionner tous les jaugeurs dans la base 

de données.

Régler l'état d'interrogation

Pour régler l'état d'interrogation, cliquez sur l'un des boutons en haut de l'écran.

• Set Normal Scan

Met tous les jaugeurs sélectionnés en état d'interrogation normal.

• Set Fast Scan

Met tous les jaugeurs sélectionnés en état d'interrogation rapide. La vitesse d'interrogation rapide 

est déterminée par le groupe Fast Scan Interleave Rate dans le moniteur Comms.

• Set Off Scan

Arrête l'interrogation pour tous les jaugeurs sélectionnés. Cela affecte toutes les Datacons 

connectés ainsi que les communications DCC.

• Set Manual Scan

Met tous les jaugeurs sélectionnés en état d'interrogation manuel. Les jaugeurs ne sont interrogés 

que sur commande de l'utilisateur.

• Set Offline

Met tous les jaugeurs sélectionnés en mode Offline dans les communications DCC. Cela affecte 

uniquement les communications DCC, les Datacons connectés continueront à interroger les 

jaugeurs mais Tankvision Professional n'interrogera pas les Datacons.

L'état d'interrogation de tous les jaugeurs est automatiquement actualisé dans l'affichage Scan 

Controller après n'importe quelle action.
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	Le débit est négatif et l'indicateur de direction de remplissage pointe vers le bas.
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	Dans l'image écran ci-dessus, la cuve est en état Disconnected mais conserve les données de sa de...
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	Les commandes disponibles sont expliquées et décrites ci-dessous.
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	Réaliser un test de répétabilité sur un appareil de jaugeage servo. Cette commande tentera de mon...
	Cette commande n'est disponible que pour les appareils de jaugeage servo.
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	• Normal Scan
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	Utilisé lorsque le jaugeur est Off Scan, pour qu'il soit interrogé une fois
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	Connect, Disconnect, Connect Once sont des options qui s'excluent mutuellement et qui déterminent...
	Connect, Disconnect, Connect Once sont des options qui s'excluent mutuellement et qui déterminent...
	• Connect
	• Connect
	• Connect
	• Connect

	L'interface se connecte au port COM ou modem et continue d'interroger les jaugeurs indéfiniment o...

	• Disconnect
	• Disconnect
	• Disconnect

	L'interface se déconnecte du port COM ou du modem et reste déconnectée.

	• Connect Once
	• Connect Once
	• Connect Once

	L'interface se connecte au port COM ou au modem et se déconnecte automatiquement lorsqu'elle a ré...
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	3 Single Tank Overview
	La vue Single Tank Overview donne un aperçu détaillé de toutes les données d'une cuve unique.
	La vue Single Tank Overview donne un aperçu détaillé de toutes les données d'une cuve unique.

	Elle peut être lancée :
	Elle peut être lancée :
	Elle peut être lancée :
	• En double-cliquant sur une fenêtre Tank View
	• En double-cliquant sur une fenêtre Tank View

	• En cliquant sur le bouton Single Tank Overview de la barre d'outils
	• En cliquant sur le bouton Single Tank Overview de la barre d'outils


	Une fois le module Single Tank Overview chargé, d'autres cuves peuvent être visualisées en les sé...
	Les données affichées sont organisées en groupes logiques ; Primary Gauging data, Flow Rates, Inv...
	Les valeurs de données en mode manuel sont affichées en vert sur fond noir.
	Les données indisponibles pour n'importe quelle raison seront remplacées par un numéro de diagnos...
	Voir l'illustration ci-dessous pour un exemple typique.
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	Les infobulles donnent des informations sur chacun des champs de données.
	Pour une description détaillée et la définition de chacun des champs, voir le chapitre Définitions.

	3.1 Cuve sous alarme
	3.1 Cuve sous alarme
	Si la cuve sélectionnée a une alarme active, une icône d'alarme s'affiche sur la cuve. Le détail ...
	Si la cuve sélectionnée a une alarme active, une icône d'alarme s'affiche sur la cuve. Le détail ...
	Dans le récapitulatif des alarmes, une coche apparaît à côté de chaque alarme active.
	Voir l'illustration ci-dessous.
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	3.2 Visualiser les températures
	3.2 Visualiser les températures
	Certains jaugeurs sont capables de mesurer des points multiples à partir de capteurs de températu...
	Certains jaugeurs sont capables de mesurer des points multiples à partir de capteurs de températu...
	Les profils de température ne peuvent être visualisés que si
	a. Le système a été configuré pour interroger les températures. Pour cela, assurez-vous que
	a. Le système a été configuré pour interroger les températures. Pour cela, assurez-vous que
	a. Le système a été configuré pour interroger les températures. Pour cela, assurez-vous que

	b. Le sous-système Trending est configuré pour suivre la tendance des éléments de température pou...
	b. Le sous-système Trending est configuré pour suivre la tendance des éléments de température pou...


	Pour plus de détails sur les options ci-dessus, voir le manuel de configuration.


	3.2.1 Afficher le profil de température
	3.2.1 Afficher le profil de température
	Pour afficher l'écran Temperature Profile, cliquez sur
	Pour afficher l'écran Temperature Profile, cliquez sur
	L'affichage suivant est typique :
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	3.2.2 Format d'affichage graphique
	3.2.2 Format d'affichage graphique
	Les données peuvent être affichées dans un format graphique à l'aide de l'onglet
	Les données peuvent être affichées dans un format graphique à l'aide de l'onglet

	Configurer le format d'affichage
	Configurer le format d'affichage
	L'affichage graphique peut être configuré à l'aide des options de menu suivantes :
	L'affichage graphique peut être configuré à l'aide des options de menu suivantes :
	L'affichage graphique peut être configuré à l'aide des options de menu suivantes :
	• View -> Average Temperature
	• View -> Average Temperature
	• View -> Average Temperature

	Cochez cette option pour afficher la température moyenne.

	• View -> Data Points
	• View -> Data Points
	• View -> Data Points

	Cochez cette option pour visualiser les points de données individuels sur le graphe.

	• View -> Data Labels
	• View -> Data Labels
	• View -> Data Labels

	Cochez cette option pour visualiser les valeurs de données individuelles sur le graphe.

	• Tools -> Options
	• Tools -> Options
	• Tools -> Options

	Une boîte de dialogue s'affiche, dans laquelle on peut régler les couleurs utilisées pour les dif...

	• Tools -> Configure Element Levels
	• Tools -> Configure Element Levels
	• Tools -> Configure Element Levels

	Une boîte de dialogue s'affiche, dans laquelle on peut entrer la hauteur des éléments de températ...




	Plage d’affichage
	Plage d’affichage
	Par défaut, la température sur le graphe est mise à l'échelle en utilisant les valeurs minimum et...
	Par défaut, la température sur le graphe est mise à l'échelle en utilisant les valeurs minimum et...


	Mémoriser le graphe
	Mémoriser le graphe
	Le graphe peut être mémorisé en format bitmap en sélectionnant
	Le graphe peut être mémorisé en format bitmap en sélectionnant



	3.2.3 Format d'affichage tabulaire
	3.2.3 Format d'affichage tabulaire
	Les données peuvent également être visualisées sous forme de tableau en cliquant sur l'onglet
	Les données peuvent également être visualisées sous forme de tableau en cliquant sur l'onglet
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	Le tableau des températures peut être imprimé ou prévisualisé en sélectionnant



	3.3 Visualiser les données de profil
	3.3 Visualiser les données de profil
	Certains jaugeurs sont capables de réaliser un profil de densité/température (ou uniquement la de...
	Certains jaugeurs sont capables de réaliser un profil de densité/température (ou uniquement la de...
	Ces données sont alors retournées sous la forme d'un tableau des densités et des températures (si...
	Les données de profil peuvent ensuite être visualisées sous forme de graphique ou de tableau.
	Il y a deux écrans pour la visualisation des données de profil :
	Il y a deux écrans pour la visualisation des données de profil :
	• Single Profile Viewer
	• Single Profile Viewer
	• Single Profile Viewer

	Un seul profil peut être affiché à la fois.

	• Profile Viewer
	• Profile Viewer
	• Profile Viewer

	jusqu'à 6 profils peuvent être affichés en même temps.


	Les deux écrans s'ouvrent à partir de l'écran Single Tank Overview.



	4 Se connecter
	4 Se connecter
	L'accès aux caractéristiques du système peut être contrôlé via un compte utilisateur. L'obligatio...
	L'accès aux caractéristiques du système peut être contrôlé via un compte utilisateur. L'obligatio...

	4.1 Se connecter à Tankvision Professional
	4.1 Se connecter à Tankvision Professional
	1. Sélectionnez
	1. Sélectionnez
	1. Sélectionnez
	1. Sélectionnez
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	2. Une invite à se connecter apparaîtra.
	2. Une invite à se connecter apparaîtra.
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	3. Entrez le nom d'utilisateur et le mot de passe nécessaires.
	3. Entrez le nom d'utilisateur et le mot de passe nécessaires.
	Les détails sont vérifiés par rapport aux entrées dans la base de données. Si le nom d'utilisateu...

	4. Lorsqu'un utilisateur est connecté au système, son nom d'utilisateur est affiché à la gauche d...
	4. Lorsqu'un utilisateur est connecté au système, son nom d'utilisateur est affiché à la gauche d...
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	Chaque compte utilisateur a un niveau d'accès désigné à chaque fonction. Ce qui signifie que même...



	4.2 Se déconnecter de Tankvision Professional
	4.2 Se déconnecter de Tankvision Professional
	Sélectionnez l'option
	Sélectionnez l'option
	Le système déconnecte immédiatement l'utilisateur actuellement connecté.
	Cela empêche l'accès à toutes les fonctions nécessitant une connexion.


	4.3 Configurer de nouveaux comptes utilisateur
	4.3 Configurer de nouveaux comptes utilisateur
	Pour plus d'informations, voir le chapitre Configuration de la sécurité du manuel Administrateurs...
	Pour plus d'informations, voir le chapitre Configuration de la sécurité du manuel Administrateurs...
	Les droits d'accès à de nouveaux utilisateurs doivent être donnés après mûre réflexion. Le niveau...

	Nous recommandons de ne donner aux utilisateurs occasionnels que le minimum de droits pour commen...
	Il est toujours possible de les ajuster ultérieurement si les utilisateurs deviennent des utilisa...



	5 Alarmes et événements
	5 Alarmes et événements
	Les alarmes et événements sont affichés sur l'écran Alarm Event Viewer disponible en permanence.
	Les alarmes et événements sont affichés sur l'écran Alarm Event Viewer disponible en permanence.

	5.1 Que se passe-t-il si une alarme se produit
	5.1 Que se passe-t-il si une alarme se produit
	• Une icône d'alarme est affichée sur la cuve dans la fenêtre Tank View, voir ci-dessous.
	• Une icône d'alarme est affichée sur la cuve dans la fenêtre Tank View, voir ci-dessous.
	• Une icône d'alarme est affichée sur la cuve dans la fenêtre Tank View, voir ci-dessous.
	• Une icône d'alarme est affichée sur la cuve dans la fenêtre Tank View, voir ci-dessous.
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	• La description de l'état d'alarme dans Grid View et Single Tank Overview change pour montrer l'...
	• La description de l'état d'alarme dans Grid View et Single Tank Overview change pour montrer l'...

	• Un événement est généré par le système et affiché dans l'écran Alarm Event Viewer.
	• Un événement est généré par le système et affiché dans l'écran Alarm Event Viewer.
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	• Un signal sonore, s'il est activé, est généré. Il peut avoir la forme d'un avertisseur interne ...
	• Un signal sonore, s'il est activé, est généré. Il peut avoir la forme d'un avertisseur interne ...

	• Les alarmes deviennent silencieuses une fois acquittées. Si la sécurité est activée, les utilis...
	• Les alarmes deviennent silencieuses une fois acquittées. Si la sécurité est activée, les utilis...

	• Les alarmes et événements sont tous consignés dans la base de données. Un historique des alarme...
	• Les alarmes et événements sont tous consignés dans la base de données. Un historique des alarme...

	• Lorsqu'une alarme est acquittée, la date et l'heure sont consignées dans la base de données. L'...
	• Lorsqu'une alarme est acquittée, la date et l'heure sont consignées dans la base de données. L'...




	5.2 Acquitter des alarmes
	5.2 Acquitter des alarmes
	L'Alarm Event Viewer affiche les détails des alarmes de la façon suivante :
	L'Alarm Event Viewer affiche les détails des alarmes de la façon suivante :
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	5.2.1 Etat des alarmes
	5.2.1 Etat des alarmes
	L'état de l'alarme est indiqué dans la colonne la plus à gauche et la plus à droite :
	L'état de l'alarme est indiqué dans la colonne la plus à gauche et la plus à droite :
	• Rouge
	• Rouge
	• Rouge
	• Rouge

	Non acquittée et non silencieuse. Pour une alarme "Active" (voir 5.3.4 Options de notification), ...

	• Bleu clair
	• Bleu clair
	• Bleu clair

	Silencieuse mais pas acquittée.

	• Vert
	• Vert
	• Vert

	Acquittée.




	5.2.2 Couper et acquitter les alarmes
	5.2.2 Couper et acquitter les alarmes
	Pour couper ou acquitter une alarme, il est nécessaire de la sélectionner en cliquant sur la lign...
	Pour couper ou acquitter une alarme, il est nécessaire de la sélectionner en cliquant sur la lign...

	Acquitter une alarme
	Acquitter une alarme
	1. L'alarme sélectionnée peut être acquittée en cliquant sur le bouton
	1. L'alarme sélectionnée peut être acquittée en cliquant sur le bouton
	1. L'alarme sélectionnée peut être acquittée en cliquant sur le bouton
	1. L'alarme sélectionnée peut être acquittée en cliquant sur le bouton

	2. Si l'alarme sélectionnée a été configurée pour exiger un motif d'acquittement, l'écran des mot...
	2. Si l'alarme sélectionnée a été configurée pour exiger un motif d'acquittement, l'écran des mot...
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	3. Le bouton
	3. Le bouton




	Couper une alarme
	Couper une alarme
	L'alarme sélectionnée peut être coupée en cliquant sur le bouton
	L'alarme sélectionnée peut être coupée en cliquant sur le bouton


	Acquitter ou couper des alarmes multiples
	Acquitter ou couper des alarmes multiples
	Il est également possible d'acquitter ou de couper une alarme unique ou des alarmes multiples en ...
	Il est également possible d'acquitter ou de couper une alarme unique ou des alarmes multiples en ...
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	Si l'une des alarmes non acquittées requiert un motif d'acquittement, le message suivant s'affich...
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0023

	Toutes les alarmes exigeant un motif d'acquittement doivent être acquittées individuellement avan...




	5.3 Event History Viewer
	5.3 Event History Viewer
	L'Event History Viewer peut être lancé soit en cliquant sur le bouton correspondant dans la barre...
	L'Event History Viewer peut être lancé soit en cliquant sur le bouton correspondant dans la barre...
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	Par défaut, tous les événements du jour en cours sont affichés. Les événements affichés peuvent ê...
	Le visualiseur d'événements affiche également les détails d'actions auditables. Il est possible d...
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	6 Rapports
	6 Rapports
	Un jeu standard de rapports de tank gauging et de stock est proposé.
	Un jeu standard de rapports de tank gauging et de stock est proposé.
	Pour accéder aux rapports, procédez de la façon suivante :
	Pour accéder aux rapports, procédez de la façon suivante :
	1. Choisissez
	1. Choisissez
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	2. Sélectionnez le type de rapport à imprimer :
	2. Sélectionnez le type de rapport à imprimer :
	– Group Selection
	– Group Selection
	– Group Selection
	– Group Selection
	– Group Selection

	Rapport pour un groupe de cuves défini par l'utilisateur.

	– Product Selection
	– Product Selection
	– Product Selection

	Rapport récapitulant toutes les cuves contenant un produit particulier (par ex. Jet A1).

	– Standard Inventory Report
	– Standard Inventory Report
	– Standard Inventory Report

	Montre une sélection standard des données de stock pour toutes les cuves.

	– Standard Summary Report
	– Standard Summary Report
	– Standard Summary Report

	Récapitule le stock de produits pour toutes les cuves par produit.

	– Gauge Configuration
	– Gauge Configuration
	– Gauge Configuration

	Rapport montrant les données principales de configuration des jaugeurs.

	– Tank Configuration
	– Tank Configuration
	– Tank Configuration

	Rapport montrant les données principales de configuration des cuves.

	– Custom Print
	– Custom Print
	– Custom Print

	Permet de sélectionner un rapport produit par un tiers, à exécuter par le système de tank gauging...




	3. Cliquez sur le bouton
	3. Cliquez sur le bouton

	4. Sélectionnez les dimensions du rapport à imprimer.
	4. Sélectionnez les dimensions du rapport à imprimer.

	5. Cliquez sur le bouton
	5. Cliquez sur le bouton

	6. Sélectionnez
	6. Sélectionnez
	– Preview
	– Preview
	– Preview
	– Preview
	– Preview

	Affiche une copie du rapport sélectionné à l'écran.

	– Print
	– Print
	– Print

	Imprime le rapport sur votre imprimante Windows par défaut.







	7 Grille
	7 Grille
	GridView est une vue tabulaire des données des cuves.
	GridView est une vue tabulaire des données des cuves.
	L'application GridView est personnalisable et comprend un menu contextuel pour envoyer les comman...
	L'utilisateur peut créer ses propres vues de données et les combiner à des fonctions standard de ...
	Pour lancer GridView, cliquez sur le bouton approprié dans la barre d'outils.

	7.1 Lancer le module Grid View
	7.1 Lancer le module Grid View
	Cliquez sur le bouton GridView dans la barre d'outils ou lancez l'application GridView.exe à part...
	Cliquez sur le bouton GridView dans la barre d'outils ou lancez l'application GridView.exe à part...
	L'illustration ci-dessous est typique.
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0027



	7.2 Sélectionner les vues des données
	7.2 Sélectionner les vues des données
	Grid View s'ouvre par défaut avec plusieurs vues de données prédéfinies.
	Grid View s'ouvre par défaut avec plusieurs vues de données prédéfinies.
	Les vues de données disponibles sont listées dans la liste déroulante sur la barre d'outils.
	Voir l'illustration ci-dessous pour information.
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	Les vues fixes sont :
	Les vues fixes sont :
	• Tank Gauging
	• Tank Gauging

	• Tank Inventory
	• Tank Inventory

	• Gauge Status
	• Gauge Status


	Chaque vue contient différentes colonnes d'informations.
	Toutes les autres vues listées sont des vues définies par l'utilisateur.
	D'autres vues peuvent être configurées par l'utilisateur.


	7.3 Sélectionner les groupes de cuves
	7.3 Sélectionner les groupes de cuves
	Par défaut, le module GridView affiche toutes les cuves.
	Par défaut, le module GridView affiche toutes les cuves.
	Grid View permet à l'utilisateur de choisir l'un des groupes de cuves préconfigurés pour afficher...
	Les groupes de données disponibles sont listés dans la liste déroulante sur la barre d'outils.
	Voir l'illustration ci-dessous pour information.
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	Si aucun groupe n'a été configuré, la liste sera vide en dehors du groupe


	7.4 Trouver une cuve spécifique
	7.4 Trouver une cuve spécifique
	GridView permet à l'utilisateur de trouver une cuve dans la liste des cuves. Si l'identité de la ...
	GridView permet à l'utilisateur de trouver une cuve dans la liste des cuves. Si l'identité de la ...


	7.5 Cuves sous alarme
	7.5 Cuves sous alarme
	Un certain nombre de boutons de la barre d'outils permettent de récapituler rapidement les cuves ...
	Un certain nombre de boutons de la barre d'outils permettent de récapituler rapidement les cuves ...
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	7.6 Configurer une nouvelle vue de données
	7.6 Configurer une nouvelle vue de données
	1. Déroulez le menu
	1. Déroulez le menu
	1. Déroulez le menu
	1. Déroulez le menu

	2. Sélectionnez l'option
	2. Sélectionnez l'option
	L'écran Maintain Views s'affiche :
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	3. Pour créer une nouvelle vue, cliquez sur le bouton
	3. Pour créer une nouvelle vue, cliquez sur le bouton
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	4. Pour une nouvelle vue, le nom de la vue est vierge mais doit être entré avant de pouvoir mémor...
	4. Pour une nouvelle vue, le nom de la vue est vierge mais doit être entré avant de pouvoir mémor...

	5. La liste sur la gauche est la liste des champs disponibles pour être ajoutés à la vue.
	5. La liste sur la gauche est la liste des champs disponibles pour être ajoutés à la vue.
	La liste peut être triée
	– par type (
	– par type (
	– par type (
	– par type (

	– alphabétiquement (
	– alphabétiquement (

	– non triée (
	– non triée (




	6. Pour ajouter un champ à la vue, sélectionnez-le et cliquez sur le bouton Add (
	6. Pour ajouter un champ à la vue, sélectionnez-le et cliquez sur le bouton Add (
	Pour ajouter tous les champs d'un type donné à la vue, sélectionnez n'importe quel champ de ce ty...

	7. La liste sur la droite est la liste des champs actuellement dans la vue.
	7. La liste sur la droite est la liste des champs actuellement dans la vue.
	Pour supprimer un champ de la vue, sélectionnez-le et cliquez sur le bouton Remove (
	Pour supprimer tous les champs de la vue, cliquez sur le bouton Remove all (

	8. Pour sauvegarder les changements et quitter, cliquez sur le bouton
	8. Pour sauvegarder les changements et quitter, cliquez sur le bouton
	Pour quitter sans sauvegarder les changements, cliquez sur le bouton

	9. Pour effacer une vue, sélectionnez-la et cliquez sur le bouton
	9. Pour effacer une vue, sélectionnez-la et cliquez sur le bouton

	10. Pour quitter l'écran Maintain Views, cliquez sur le bouton
	10. Pour quitter l'écran Maintain Views, cliquez sur le bouton

	11. Déroulez la liste des vues dans la barre d'outils de l'application GridView.
	11. Déroulez la liste des vues dans la barre d'outils de l'application GridView.
	La nouvelle vue doit être dans la liste.
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	7.7 Couleur du débit
	7.7 Couleur du débit
	Lorsqu'il y a une colonne Flow Rate dans la vue, la ligne affichant une cuve en mouvement se colo...
	Lorsqu'il y a une colonne Flow Rate dans la vue, la ligne affichant une cuve en mouvement se colo...
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	La grille conserve trois valeurs seuils configurables par l'utilisateur pour déterminer quand une...
	Pour configurer les valeurs seuils, sélectionnez
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	Si l'un des champs de données dépasse la consigne, la ligne deviendra brune ou bleue selon la dir...
	Vous ne pouvez pas régler les seuils sur zéro.
	La valeur seuil du niveau dans la vue grille est indépendante du seuil similaire configuré pour l...


	7.8 Impression et aperçu avant impression
	7.8 Impression et aperçu avant impression
	Le contenu actuel de la grille peut être envoyé à une imprimante ou prévisualisé à l'écran.
	Le contenu actuel de la grille peut être envoyé à une imprimante ou prévisualisé à l'écran.

	7.8.1 Imprimer une grille
	7.8.1 Imprimer une grille
	Pour imprimer le contenu d'une grille, sélectionnez
	Pour imprimer le contenu d'une grille, sélectionnez
	Si l'option de menu est utilisée, il est possible de modifier l'imprimante et les réglages de l'i...
	Si vous utilisez le bouton de la barre d'outils, le contenu actuel de la grille est imprimé sur l...


	7.8.2 Prévisualiser une grille
	7.8.2 Prévisualiser une grille
	Pour imprimer une prévisualisation, sélectionnez
	Pour imprimer une prévisualisation, sélectionnez
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	8 Commandes de jaugeurs
	8 Commandes de jaugeurs
	Les commandes de jaugeurs peuvent être spécifiques au jaugeur et dépendent, par conséquent, du ty...
	Les commandes de jaugeurs peuvent être spécifiques au jaugeur et dépendent, par conséquent, du ty...
	Par exemple, les jaugeurs Enraf prennent en charge les fonctions suivantes :
	• Dipping
	• Dipping
	• Dipping
	• Dipping

	Propose différents modes de mesure d'interface, tels que Find Water Interface, Find Product Inter...

	• Displacement
	• Displacement
	• Displacement

	Propose des fonctions de commande du displacer.

	• Test Gauge Alarm
	• Test Gauge Alarm
	• Test Gauge Alarm

	Permet de réaliser l'auto-test des consignes d'alarme du jaugeur radar 873.

	• Maintenance
	• Maintenance
	• Maintenance

	Permet de régler le niveau de référence du jaugeur.

	• Gauge Items
	• Gauge Items
	• Gauge Items

	Outil général permettant de lire ou d'écrire n'importe quelle option de jaugeur et de visualiser ...


	Les autres jaugeurs peuvent prendre en charge d'autres fonctions de commande et de configuration.

	8.1 Lancer des commandes de jaugeurs
	8.1 Lancer des commandes de jaugeurs
	1. Déroulez le menu Tools, sélectionnez l'option Gauge Command.
	1. Déroulez le menu Tools, sélectionnez l'option Gauge Command.
	1. Déroulez le menu Tools, sélectionnez l'option Gauge Command.
	1. Déroulez le menu Tools, sélectionnez l'option Gauge Command.

	2. L'application sélectionne automatiquement le jaugeur principal de la cuve si la cuve a plus d'...
	2. L'application sélectionne automatiquement le jaugeur principal de la cuve si la cuve a plus d'...
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	8.2 Envoyer une commande
	8.2 Envoyer une commande
	1. Sélectionnez la cuve dans une liste sur le panneau de gauche. Développez la cuve avec le symbo...
	1. Sélectionnez la cuve dans une liste sur le panneau de gauche. Développez la cuve avec le symbo...
	1. Sélectionnez la cuve dans une liste sur le panneau de gauche. Développez la cuve avec le symbo...
	1. Sélectionnez la cuve dans une liste sur le panneau de gauche. Développez la cuve avec le symbo...
	Les commandes prises en charge par le jaugeur sont activées.
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	2. Sélectionnez la commande appropriée dans la liste.
	2. Sélectionnez la commande appropriée dans la liste.

	3. Réglez les paramètres requis et cliquez sur le bouton d'action (Execute, Dip, etc.).
	3. Réglez les paramètres requis et cliquez sur le bouton d'action (Execute, Dip, etc.).
	En général, la réaction et l'état de la commande sont retournés à l'utilisateur via le panneau au...
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	8.2.1 Fonctions de jaugeage
	8.2.1 Fonctions de jaugeage
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	Elles s'appliquent généralement à la série Enraf 854 de jaugeurs servo.

	Product Measurement Mode
	Product Measurement Mode
	• Envoie l'option I1.
	• Envoie l'option I1.
	• Envoie l'option I1.
	• Envoie l'option I1.

	• Affiche l'état du jaugeur.
	• Affiche l'état du jaugeur.

	• Le jaugeur reste à I1 jusqu'à ce que l'utilisateur émette une autre commande.
	• Le jaugeur reste à I1 jusqu'à ce que l'utilisateur émette une autre commande.




	Density Dip
	Density Dip
	Cette fonction a deux options :
	Cette fonction a deux options :
	Sélectionnez la bonne option et cliquez sur le bouton Apply.
	La commande sera exécutée.


	Water Measurement Mode
	Water Measurement Mode
	• Envoie l'option I3.
	• Envoie l'option I3.
	• Envoie l'option I3.
	• Envoie l'option I3.

	• Affiche l'état du jaugeur.
	• Affiche l'état du jaugeur.

	• Le jaugeur reste à I3 jusqu'à ce que l'utilisateur émette une autre commande.
	• Le jaugeur reste à I3 jusqu'à ce que l'utilisateur émette une autre commande.





	8.2.2 Fonctions du displacer
	8.2.2 Fonctions du displacer
	Lock
	Lock
	<GRAPHIC>
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0041

	• Verrouille le displacer à un niveau donné.
	• Verrouille le displacer à un niveau donné.
	• Verrouille le displacer à un niveau donné.

	• Utilise l'option MZ pour régler le niveau de verrouillage, suivi de la commande LT.
	• Utilise l'option MZ pour régler le niveau de verrouillage, suivi de la commande LT.

	• L'utilisateur doit indiquer le niveau auquel le displacer sera verrouillé.
	• L'utilisateur doit indiquer le niveau auquel le displacer sera verrouillé.

	• Le jaugeur restera en position verrouillée jusqu'à ce que l'utilisateur lui donne un contre-ordre.
	• Le jaugeur restera en position verrouillée jusqu'à ce que l'utilisateur lui donne un contre-ordre.




	Verify Calibration
	Verify Calibration
	<GRAPHIC>
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0042

	• Vérifie l'étalonnage de l'appareil. Le displacer monte jusque dans la chambre d'étalonnage du j...
	• Vérifie l'étalonnage de l'appareil. Le displacer monte jusque dans la chambre d'étalonnage du j...
	• Vérifie l'étalonnage de l'appareil. Le displacer monte jusque dans la chambre d'étalonnage du j...

	• Utilise l'option CA.
	• Utilise l'option CA.

	• Le jaugeur restera en mode étalonnage jusqu'à ce que l'utilisateur lui donne un contre-ordre.
	• Le jaugeur restera en mode étalonnage jusqu'à ce que l'utilisateur lui donne un contre-ordre.

	• Mémorise et affiche le niveau initial.
	• Mémorise et affiche le niveau initial.

	• Affiche les différents changements d'état qui se sont produits.
	• Affiche les différents changements d'état qui se sont produits.

	• Appuyez sur le bouton Unlock pour que le displacer retourne en mode Product Measurement.
	• Appuyez sur le bouton Unlock pour que le displacer retourne en mode Product Measurement.




	Unlock
	Unlock
	• Déverrouille le jaugeur de la position verrouillée ou de la position d'étalonnage.
	• Déverrouille le jaugeur de la position verrouillée ou de la position d'étalonnage.
	• Déverrouille le jaugeur de la position verrouillée ou de la position d'étalonnage.
	• Déverrouille le jaugeur de la position verrouillée ou de la position d'étalonnage.

	• Envoie l'option UN.
	• Envoie l'option UN.





	8.2.3 Maintenance
	8.2.3 Maintenance
	<GRAPHIC>
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0043

	Règle le jaugeur à un nouveau relevé de niveau.
	Si le jaugeur diffère du jaugeage manuel de l'utilisateur, il faut réaligner le jaugeur au jaugea...
	L'utilisateur doit fournir le nouveau relevé de niveau et le mot de passe pour accéder au jaugeur.
	Cette fonction utilise toute une séquence d'options de jaugeur :
	La procédure :
	La procédure :
	La procédure :

	1. Sélectionnez la cuve nécessitant un nouveau relevé de niveau.
	1. Sélectionnez la cuve nécessitant un nouveau relevé de niveau.

	2. Entrez le nouveau niveau du jaugeur.
	2. Entrez le nouveau niveau du jaugeur.

	3. Appuyez sur le bouton Dip.
	3. Appuyez sur le bouton Dip.
	La séquence d'actions ci-dessus se déroule.
	L'état de chaque transition doit être affiché.

	Lorsque la commande EX est émise à la fin, les données du jaugeur peuvent disparaître pendant un ...



	8.2.4 Eléments de jaugeage
	8.2.4 Eléments de jaugeage
	<GRAPHIC>
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0044
	Cette fonction ne s'applique qu'aux jaugeurs Enraf et Motherwell.
	L'utilisation de cette fonction requiert une bonne connaissance du dispositif de jaugeage, et il ...

	Cette fonction permet à l'utilisateur de lire/écrire n'importe laquelle des options de configurat...

	Options des jaugeurs Enraf
	Options des jaugeurs Enraf
	Conversion des unités
	Conversion des unités
	Cet onglet permet la conversion des unités affichées dans Tankvision Professional dans les unités...
	Cet onglet permet la conversion des unités affichées dans Tankvision Professional dans les unités...


	Lire une requête
	Lire une requête
	Pour lire une requête, il n'y a pas de données à fournir. Les données seront converties dans les ...
	Pour lire une requête, il n'y a pas de données à fournir. Les données seront converties dans les ...


	Format des données
	Format des données
	Lors du réglage des options, l'utilisateur doit entrer les données dans le format exact approprié...
	Lors du réglage des options, l'utilisateur doit entrer les données dans le format exact approprié...


	Liste des dimensions/unités prises en charge
	Liste des dimensions/unités prises en charge
	Touche :
	Touche :
	Touche :
	• ±
	• ±
	• ±


	• N
	• N
	• N


	• . signe décimal
	• . signe décimal



	<TABLE>
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Niveau
	Niveau
	Niveau




	<TABLE BODY>
	<TABLE ROW>
	Unités
	Unités
	Unités


	Format
	Format
	Format



	<TABLE ROW>
	mm
	mm

	± N N N N N N . N (par défaut)
	± N N N N N N . N (par défaut)


	<TABLE ROW>
	m
	m

	± N N N . N N N N
	± N N N . N N N N


	<TABLE ROW>
	ft
	ft

	± N N N N . N N N
	± N N N N . N N N


	<TABLE ROW>
	in
	in

	± N N N N N . N N
	± N N N N N . N N


	<TABLE ROW>
	f-i-s
	f-i-s

	± N N ' N N " N N
	± N N ' N N " N N






	<TABLE>
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Température
	Température
	Température




	<TABLE BODY>
	<TABLE ROW>
	Unités
	Unités
	Unités


	Format
	Format
	Format



	<TABLE ROW>
	˚C
	˚C

	± N N N . N N (par défaut)
	± N N N . N N (par défaut)


	<TABLE ROW>
	˚F
	˚F

	± N N N . N N
	± N N N . N N






	<TABLE>
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Densité
	Densité
	Densité




	<TABLE BODY>
	<TABLE ROW>
	Unités
	Unités
	Unités


	Format
	Format
	Format



	<TABLE ROW>
	kg/l
	kg/l

	± N N . N N N N N (par défaut)
	± N N . N N N N N (par défaut)


	<TABLE ROW>
	kg/m¸
	kg/m¸

	± N N N N N . N N
	± N N N N N . N N


	<TABLE ROW>
	lb/ft¸
	lb/ft¸

	± N N N . N N N N
	± N N N . N N N N


	<TABLE ROW>
	˚API
	˚API

	± N N N N . N N N
	± N N N N . N N N






	<TABLE>
	<TABLE>
	<TABLE>
	<TABLE HEADING>
	<TABLE ROW>
	Pression


	<TABLE BODY>
	<TABLE ROW>
	Unités
	Unités
	Unités


	Format
	Format
	Format



	<TABLE ROW>
	bar
	bar

	± N N . N N N N N (par défaut)
	± N N . N N N N N (par défaut)


	<TABLE ROW>
	Pa
	Pa

	± N N N N N N . N
	± N N N N N N . N


	<TABLE ROW>
	kPa
	kPa

	± N N N N . N N N
	± N N N N . N N N


	<TABLE ROW>
	lb/in·
	lb/in·

	± N N N . N N N N
	± N N N . N N N N





	Toutes les autres options utilisent des formats fixés qui ne sont pas touchés par les dimensions/...



	Options des jaugeurs Motherwell
	Options des jaugeurs Motherwell
	Les options des jaugeurs Motherwell ne disposent pas de la même fonction de conversion des unités...
	Les options des jaugeurs Motherwell ne disposent pas de la même fonction de conversion des unités...
	Avec les jaugeurs Motherwell, vous pouvez soit spécifier le code option hexadécimal à 2 chiffres,...
	<TABLE>
	<TABLE>
	<TABLE BODY>
	<TABLE ROW>
	Code abrégé
	Code abrégé
	Code abrégé


	Description
	Description
	Description



	<TABLE ROW>
	UR
	UR

	Upper Reference Level (niveau de référence supérieur)
	Upper Reference Level (niveau de référence supérieur)


	<TABLE ROW>
	RL
	RL

	Reference Level (niveau de référence)
	Reference Level (niveau de référence)


	<TABLE ROW>
	HH
	HH

	High High Alarm Level (niveau d'alarme haut haut)
	High High Alarm Level (niveau d'alarme haut haut)


	<TABLE ROW>
	HA
	HA

	High Alarm Level (niveau d'alarme haut)
	High Alarm Level (niveau d'alarme haut)


	<TABLE ROW>
	LA
	LA

	Low Alarm Level (niveau d'alarme bas)
	Low Alarm Level (niveau d'alarme bas)


	<TABLE ROW>
	LL
	LL

	Low Low Alarm Level (niveau d'alarme bas bas)
	Low Low Alarm Level (niveau d'alarme bas bas)










	9 Regroupement de cuves
	9 Regroupement de cuves
	Le système propose toute une série d'outils et de fonctions pour organiser et regrouper les cuves...
	Le système propose toute une série d'outils et de fonctions pour organiser et regrouper les cuves...
	Toutes les fonctions de regroupement de cuves sont généralement disponibles à partir du module Ta...
	Le regroupement est en général organisé en groupes statiques et groupes dynamiques.
	Le regroupement est en général organisé en groupes statiques et groupes dynamiques.
	• Les groupes statiques
	• Les groupes statiques
	• Les groupes statiques


	• Les groupes dynamiques
	• Les groupes dynamiques
	• Les groupes dynamiques



	L'affichage du module Tank Grouping comprend une boîte de dialogue à plusieurs onglets. Chaque on...
	L'accès à certaines fonctions de regroupement des cuves est protégé par un mot de passe. Vous ser...

	9.1 Configurer et utiliser un groupe statique
	9.1 Configurer et utiliser un groupe statique
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur

	2. Cliquez sur l'onglet
	2. Cliquez sur l'onglet
	<GRAPHIC>
	<GRAPHIC>


	3. Appuyez sur le bouton
	3. Appuyez sur le bouton
	<GRAPHIC>
	<GRAPHIC>


	4. Entrez le nom du groupe, puis cliquez sur les cuves disponibles pour les ajouter ou les suppri...
	4. Entrez le nom du groupe, puis cliquez sur les cuves disponibles pour les ajouter ou les suppri...

	5. Pour sauvegarder les changements pour tous les groupes, cliquez sur le bouton
	5. Pour sauvegarder les changements pour tous les groupes, cliquez sur le bouton
	Le groupe statique peut à présent être utilisé en le sélectionnant dans le menu



	9.1.1 Editer un groupe statique existant
	9.1.1 Editer un groupe statique existant
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur

	2. Cliquez sur l'onglet
	2. Cliquez sur l'onglet

	3. Sélectionnez le groupe à modifier et appuyez sur le bouton
	3. Sélectionnez le groupe à modifier et appuyez sur le bouton
	<GRAPHIC>
	<GRAPHIC>


	4. Cliquez sur les cuves disponibles pour les ajouter ou les supprimer du groupe. Toutes les cuve...
	4. Cliquez sur les cuves disponibles pour les ajouter ou les supprimer du groupe. Toutes les cuve...

	5. Pour sauvegarder le groupe, cliquez sur le bouton
	5. Pour sauvegarder le groupe, cliquez sur le bouton

	6. Pour sauvegarder les changements pour tous les groupes, cliquez sur le bouton
	6. Pour sauvegarder les changements pour tous les groupes, cliquez sur le bouton
	Le groupe statique peut à présent être utilisé en le sélectionnant dans le menu




	9.1.2 Effacer un groupe statique existant
	9.1.2 Effacer un groupe statique existant
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur
	1. Chargez le module Tank Grouping en cliquant sur

	2. Cliquez sur l'onglet
	2. Cliquez sur l'onglet

	3. Sélectionnez le groupe de cuves à effacer de la liste des groupes.
	3. Sélectionnez le groupe de cuves à effacer de la liste des groupes.

	4. Appuyez sur le bouton
	4. Appuyez sur le bouton





	9.2 Regroupement de produits
	9.2 Regroupement de produits
	Le système permet de visualiser des cuves contenant un produit particulier.
	Le système permet de visualiser des cuves contenant un produit particulier.

	9.2.1 Utiliser un groupe de produits
	9.2.1 Utiliser un groupe de produits
	1. Chargez le module Tank Grouping en sélectionnant
	1. Chargez le module Tank Grouping en sélectionnant
	1. Chargez le module Tank Grouping en sélectionnant
	1. Chargez le module Tank Grouping en sélectionnant

	2. Cliquez sur l'onglet
	2. Cliquez sur l'onglet
	La liste des produits disponibles s'affiche :
	<GRAPHIC>
	<GRAPHIC>
	S'il y a un grand nombre de produits, vous pouvez utiliser les barres de défilement pour trouver ...


	3. Sélectionnez le produit souhaité dans la liste.
	3. Sélectionnez le produit souhaité dans la liste.
	Les cuves contenant actuellement ce produit sont listées.

	4. Le groupe de produits peut être utilisé en le sélectionnant dans le menu Product Groups dans l...
	4. Le groupe de produits peut être utilisé en le sélectionnant dans le menu Product Groups dans l...




	9.2.2 Fenêtre Product Total
	9.2.2 Fenêtre Product Total
	La fenêtre Product Total ne s'affiche que lorsque la fonction Product Grouping est utilisée.
	La fenêtre Product Total ne s'affiche que lorsque la fonction Product Grouping est utilisée.
	La fenêtre Product Total affiche des sommes de volumes pour le produit sélectionné.
	Les éventuelles autres cuves qui n'ont pas pu être incluses dans le total à cause d'une erreur ou...
	Pour plus de détails, voir l'illustration ci-dessous.
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0049




	9.3 Regroupement dynamique
	9.3 Regroupement dynamique
	Le système propose une fonction de base de regroupement dynamique qui permet de visualiser des cu...
	Le système propose une fonction de base de regroupement dynamique qui permet de visualiser des cu...
	Lorsqu'un groupe dynamique est utilisé, dès que les cuves ne remplissent plus les critères, elles...
	Le nombre de groupes dynamiques disponibles est fixe.
	Ces groupes sont définis automatiquement par le système.

	9.3.1 Utiliser un groupe dynamique
	9.3.1 Utiliser un groupe dynamique
	1. Chargez le module Tank Grouping en cliquant sur le bouton approprié de la barre d'outils.
	1. Chargez le module Tank Grouping en cliquant sur le bouton approprié de la barre d'outils.
	1. Chargez le module Tank Grouping en cliquant sur le bouton approprié de la barre d'outils.
	1. Chargez le module Tank Grouping en cliquant sur le bouton approprié de la barre d'outils.

	2. Cliquez sur l'onglet
	2. Cliquez sur l'onglet
	La liste des groupes dynamiques disponibles s'affiche :
	<GRAPHIC>
	<GRAPHIC>


	3. Sélectionnez un groupe dynamique.
	3. Sélectionnez un groupe dynamique.
	Les cuves remplissant les critères pour le groupe dynamique spécifié s'affichent. Par exemple, Mo...





	9.4 Régler les cuves à surveiller
	9.4 Régler les cuves à surveiller
	1. Chargez le module Tank Grouping en sélectionnant
	1. Chargez le module Tank Grouping en sélectionnant
	1. Chargez le module Tank Grouping en sélectionnant
	1. Chargez le module Tank Grouping en sélectionnant
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	<GRAPHIC>


	2. Sélectionnez les cuves souhaitées en cliquant dessus.
	2. Sélectionnez les cuves souhaitées en cliquant dessus.
	A la première sélection, la cuve apparaîtra sur fond bleu.
	A la sélection suivante, elle sera désélectionnée.
	– Pour sélectionner simultanément toutes les cuves, appuyez sur le bouton
	– Pour sélectionner simultanément toutes les cuves, appuyez sur le bouton
	– Pour sélectionner simultanément toutes les cuves, appuyez sur le bouton

	– Pour désélectionner simultanément toutes les cuves, appuyez sur le bouton
	– Pour désélectionner simultanément toutes les cuves, appuyez sur le bouton




	3. Appuyez sur le bouton
	3. Appuyez sur le bouton





	10 Aide et diagnostic
	10 Aide et diagnostic
	Le système contient une aide détaillée et une fonction de diagnostic.
	Le système contient une aide détaillée et une fonction de diagnostic.
	La plus grande partie de l'aide apparaît dans le menu
	Les options disponibles dans le menu

	10.1 Diagnostic
	10.1 Diagnostic
	Pour voir la signification des codes de diagnostic (numéros DN) qui apparaissent sur l'affichage ...
	Pour voir la signification des codes de diagnostic (numéros DN) qui apparaissent sur l'affichage ...

	10.1.1 Lancer le module Diagnostics
	10.1.1 Lancer le module Diagnostics
	Sélectionnez l'option Diagnostics dans le menu
	Sélectionnez l'option Diagnostics dans le menu
	Le type d'affichage suivant est chargé :
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0052

	La première colonne liste les codes de diagnostic, la deuxième contient une brève définition et l...


	10.1.2 Prévisualiser la liste de diagnostic
	10.1.2 Prévisualiser la liste de diagnostic
	Sélectionnez l'option
	Sélectionnez l'option
	Le type d'affichage suivant est chargé :
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0053

	Appuyez sur l'icône d'impression pour envoyer le rapport à l'imprimante Windows par défaut.


	10.1.3 Lancer le ficher d'actions recommandées
	10.1.3 Lancer le ficher d'actions recommandées
	Pour plus d'informations sur le code de diagnostic, double-cliquez sur la ligne en question.
	Pour plus d'informations sur le code de diagnostic, double-cliquez sur la ligne en question.
	Le bloc-notes Windows est lancé et ouvre le fichier des actions recommandées.
	Voir l'illustration ci-dessous pour un exemple typique.
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	BA00396G_0054




	10.2 Versions
	10.2 Versions
	Le menu Help dans la barre de menu de la page d'accueil contient une option appelée Versions.
	Le menu Help dans la barre de menu de la page d'accueil contient une option appelée Versions.
	Si vous sélectionnez cette option de menu, un module d'affichage est lancé et montre les versions...
	Ces informations sont utiles en cas d'appel à l'assistance technique de votre fournisseur.
	L'une des premières questions en cas d'appel sera inévitablement quelle version du module est ins...
	Il est possible d'imprimer la liste complète des modules et de leurs versions correspondantes et ...

	10.2.1 Lancer le module Versions
	10.2.1 Lancer le module Versions
	Sélectionnez l'option Versions dans le menu Help dans la barre de menu de la page d'accueil.
	Sélectionnez l'option Versions dans le menu Help dans la barre de menu de la page d'accueil.
	Le type d'affichage suivant est chargé :
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0055

	Utilisez les barres de défilement pour voir les détails de chaque fichier listé.


	10.2.2 Prévisualiser un rapport des versions de module
	10.2.2 Prévisualiser un rapport des versions de module
	Sélectionnez l'option
	Sélectionnez l'option
	Le type d'affichage suivant est chargé :
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0056

	Appuyez sur l'icône d'impression pour envoyer le rapport à l'imprimante Windows par défaut.



	10.3 About
	10.3 About
	Le menu Help dans la barre de menu de la page d'accueil contient une option appelée About.
	Le menu Help dans la barre de menu de la page d'accueil contient une option appelée About.
	Lorsqu'elle est sélectionnée, cette option de menu charge un module d'affichage montrant la versi...
	Ces informations sont utiles en cas d'appel à l'assistance technique de votre fournisseur.
	L'une des premières questions en cas d'appel sera inévitablement qui est l'utilisateur enregistré...

	10.3.1 Lancer le module About
	10.3.1 Lancer le module About
	Sélectionnez l'option
	Sélectionnez l'option
	Le type d'affichage suivant est chargé :
	<GRAPHIC>
	<GRAPHIC>
	BA00396G_0057

	Appuyez sur le bouton




	11 Tendance
	11 Tendance
	Caractéristiques clés
	Caractéristiques clés
	Caractéristiques clés
	• Jusqu'à six affichages simultanés sur un seul graphe
	• Jusqu'à six affichages simultanés sur un seul graphe

	• Axes indépendants pour chaque variable de process
	• Axes indépendants pour chaque variable de process

	• Grille d'affichage pour une meilleure lecture
	• Grille d'affichage pour une meilleure lecture

	• Curseur de données pour lire les valeurs de tendance
	• Curseur de données pour lire les valeurs de tendance

	• Prend en charge des multi-dimensions dynamiques
	• Prend en charge des multi-dimensions dynamiques

	• Zoom avant sur des données avec la fonction Zoom
	• Zoom avant sur des données avec la fonction Zoom

	• Défilement vers l'arrière et vers l'avant
	• Défilement vers l'arrière et vers l'avant

	• Extension de l'axe Y configurable par l'utilisateur
	• Extension de l'axe Y configurable par l'utilisateur

	• Base de temps programmable par l'utilisateur
	• Base de temps programmable par l'utilisateur



	11.1 Suivi des tendances et enregistrement des données
	11.1 Suivi des tendances et enregistrement des données
	Le système est équipé en standard d'un pack de suivi des tendances complet. Un dispositif d'enreg...
	Le système est équipé en standard d'un pack de suivi des tendances complet. Un dispositif d'enreg...
	Il y a deux interfaces utilisateur pour afficher les données de tendance :


	11.2 Tendance en temps réel
	11.2 Tendance en temps réel
	La fonction de tendance en temps réel combine la possibilité de remonter jusqu'aux 12 dernières h...
	La fonction de tendance en temps réel combine la possibilité de remonter jusqu'aux 12 dernières h...

	11.2.1 Lancer une tendance en temps réel
	11.2.1 Lancer une tendance en temps réel
	Cliquez sur le bouton Real-Time Trending de la barre d'outils.
	Cliquez sur le bouton Real-Time Trending de la barre d'outils.
	L'affichage de la tendance en temps réel est chargé.
	Il est chargé avec les dernières données complétant le dernier filtre temps réel entré. Au début,...


	11.2.2 Configurer l'affichage de la tendance en temps réel
	11.2.2 Configurer l'affichage de la tendance en temps réel
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	Le module de filtre de la tendance en temps réel est chargé.
	Voir l'illustration ci-dessous pour un exemple typique.
	<GRAPHIC>
	<GRAPHIC>
	Le champ du serveur n'est visible que pour les systèmes redondants. Pour les systèmes redondants,...

	– Interval
	– Interval
	– Interval
	– Interval
	– Interval

	Il s'agit de l'intervalle pour lequel les données de tendance doivent être visualisées à l'heure ...

	– Plot Interval
	– Plot Interval
	– Plot Interval

	Il s'agit de l'intervalle de temps entre les points le long de l'axe X. Notez que si Interval est...

	– Trend Fields
	– Trend Fields
	– Trend Fields

	Jusqu'à six champs peuvent être affichés. Si le mode de sélection actuel permet de sélectionner u...




	2. Sélectionnez une cuve dans la liste déroulante.
	2. Sélectionnez une cuve dans la liste déroulante.

	3. Sélectionnez la variable de process pour la cuve pour laquelle on souhaite suivre la tendance.
	3. Sélectionnez la variable de process pour la cuve pour laquelle on souhaite suivre la tendance.

	4. Les valeurs maximum et minimum optionnelles pour l'axe y peuvent également être entrées si néc...
	4. Les valeurs maximum et minimum optionnelles pour l'axe y peuvent également être entrées si néc...

	5. Cliquez sur le bouton
	5. Cliquez sur le bouton
	L'affichage de tendance est configuré pour afficher les données requises.
	Le chargement de la partie historique des données peut prendre un petit peu de temps. Cela dépend...
	Voir l'illustration ci-dessous pour un exemple de données de tendance.
	<GRAPHIC>
	<GRAPHIC>





	11.2.3 Utiliser l'affichage de la vue de tendance en temps réel
	11.2.3 Utiliser l'affichage de la vue de tendance en temps réel
	Une fois la configuration de la tendance terminée et l'affichage de la vue de tendance configuré,...
	Une fois la configuration de la tendance terminée et l'affichage de la vue de tendance configuré,...
	La tendance défile de la droite vers la gauche. Le côté droit étant l'heure actuelle.
	Les nouvelles données sont ajoutées du côté droit de l'affichage.
	Le nombre de variables de process sélectionnées détermine le nombre d'axes Y représentés sur la v...
	Chaque tendance est affichée dans une couleur unique.


	11.2.4 Trouver une valeur sur une tendance
	11.2.4 Trouver une valeur sur une tendance
	Les valeurs des variables de process à un point donné dans le temps peuvent être déterminées si l...
	Les valeurs des variables de process à un point donné dans le temps peuvent être déterminées si l...
	•
	•
	•
	Il n'est pas possible de sélectionner une heure sur le graphe et la valeur des variables de proce...

	•
	•
	Une heure peut être sélectionnée sur le graphe et les variables de process correspondantes sont a...

	•
	•
	Une heure peut être sélectionnée sur le graphe et les variables de process correspondantes sont a...


	Si le


	11.2.5 Zoom avant pour plus de détails
	11.2.5 Zoom avant pour plus de détails
	Le module de tendance permet à l'utilisateur de zoomer dans les données de tendance et les tendan...
	Le module de tendance permet à l'utilisateur de zoomer dans les données de tendance et les tendan...
	1. Si le mode de sélection actuel n'est pas
	1. Si le mode de sélection actuel n'est pas
	1. Si le mode de sélection actuel n'est pas

	2. Identifiez la zone de la tendance sur laquelle vous voulez plus de détails.
	2. Identifiez la zone de la tendance sur laquelle vous voulez plus de détails.

	3. A l'aide de la souris, tracez un cadre autour de la zone en question en cliquant avec le bouto...
	3. A l'aide de la souris, tracez un cadre autour de la zone en question en cliquant avec le bouto...

	4. Le système fera un zoom avant sur la zone sélectionnée. Une barre de défilement horizontale ap...
	4. Le système fera un zoom avant sur la zone sélectionnée. Une barre de défilement horizontale ap...

	5. Si nécessaire, vous pouvez zoomer encore plus en utilisant la même technique.
	5. Si nécessaire, vous pouvez zoomer encore plus en utilisant la même technique.

	6. Pour quitter le mode Zoom et retourner au mode de sélection, cliquez à nouveau sur le bouton Z...
	6. Pour quitter le mode Zoom et retourner au mode de sélection, cliquez à nouveau sur le bouton Z...
	Il est à présent possible de sélectionner une heure sur le graphe en cliquant dessus au lieu d'id...




	11.2.6 Zoom arrière vers la vue par défaut
	11.2.6 Zoom arrière vers la vue par défaut
	Vous pouvez effectuer un zoom arrière vers la vue par défaut de la façon suivante :
	Vous pouvez effectuer un zoom arrière vers la vue par défaut de la façon suivante :
	Vous pouvez effectuer un zoom arrière vers la vue par défaut de la façon suivante :
	1. Cliquez sur le bouton droit de la souris n'importe où sur le graphe de tendance.
	1. Cliquez sur le bouton droit de la souris n'importe où sur le graphe de tendance.
	Un menu déroulant apparaît.

	2. Sélectionnez l'option
	2. Sélectionnez l'option





	11.3 Tendance historique
	11.3 Tendance historique
	La fonction de tendance historique permet à l'utilisateur de visualiser des données de tendance h...
	La fonction de tendance historique permet à l'utilisateur de visualiser des données de tendance h...

	11.3.1 Lancer une tendance historique
	11.3.1 Lancer une tendance historique
	Cliquez sur le bouton Historical trending de la barre d'outils. Il est chargé avec les dernières ...
	Cliquez sur le bouton Historical trending de la barre d'outils. Il est chargé avec les dernières ...


	11.3.2 Configurer l'affichage de la tendance historique
	11.3.2 Configurer l'affichage de la tendance historique
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	Voir l'illustration ci-dessous pour un exemple typique.
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	Le champ du serveur n'est visible que pour les systèmes redondants. Pour les systèmes redondants,...

	– Interval
	– Interval
	– Interval
	– Interval
	– Interval

	Il s'agit de l'intervalle pour lequel les données de tendance doivent être visualisées à l'heure ...

	– Date/Time Start
	– Date/Time Start
	– Date/Time Start

	Il s'agit de la date/heure de départ pour laquelle les données de tendance historiques doivent êt...

	– Date/Time End
	– Date/Time End
	– Date/Time End

	Il s'agit de la date/heure de fin pour laquelle les données de tendance historiques doivent être ...

	– Plot Interval
	– Plot Interval
	– Plot Interval

	Il s'agit de l'intervalle de temps entre les points le long de l'axe X. Notez que si la durée ent...

	– Trend Fields
	– Trend Fields
	– Trend Fields

	Jusqu'à six champs peuvent être configurés pour afficher soit des informations en direct soit des...




	2. Sélectionnez une cuve dans la liste déroulante.
	2. Sélectionnez une cuve dans la liste déroulante.

	3. Sélectionnez la variable de process pour la cuve pour laquelle on souhaite suivre la tendance.
	3. Sélectionnez la variable de process pour la cuve pour laquelle on souhaite suivre la tendance.

	4. Les valeurs maximum et minimum optionnelles pour l'axe y peuvent également être entrées si néc...
	4. Les valeurs maximum et minimum optionnelles pour l'axe y peuvent également être entrées si néc...

	5. Cliquez sur le bouton
	5. Cliquez sur le bouton
	L'affichage de tendance est configuré pour afficher les données requises. Le chargement des donné...
	Voir l'illustration ci-dessous pour un exemple de données de tendance.
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	11.3.3 Utiliser l'affichage de la vue de tendance historique
	11.3.3 Utiliser l'affichage de la vue de tendance historique
	L'affichage des données de la tendance historique prend en charge la fonction de zoom, ce qui per...
	L'affichage des données de la tendance historique prend en charge la fonction de zoom, ce qui per...
	Le nombre de variables de process sélectionnées détermine le nombre d'axes Y représentés sur la v...
	Chaque tendance est affichée dans une couleur unique.


	11.3.4 Trouver une valeur sur une tendance
	11.3.4 Trouver une valeur sur une tendance
	Les valeurs des variables de process à un point donné dans le temps peuvent être déterminées si l...
	Les valeurs des variables de process à un point donné dans le temps peuvent être déterminées si l...
	•
	•
	•
	Il n'est pas possible de sélectionner une heure sur le graphe et la valeur des variables de proce...

	•
	•
	Une heure peut être sélectionnée sur le graphe et les variables de process correspondantes sont a...

	•
	•
	Une heure peut être sélectionnée sur le graphe et les variables de process correspondantes sont a...


	Si le


	11.3.5 Zoom avant pour plus de détails
	11.3.5 Zoom avant pour plus de détails
	Le module de tendance permet à l'utilisateur de zoomer dans les données de tendance et les tendan...
	Le module de tendance permet à l'utilisateur de zoomer dans les données de tendance et les tendan...
	1. Si le mode de sélection actuel n'est pas
	1. Si le mode de sélection actuel n'est pas
	1. Si le mode de sélection actuel n'est pas

	2. Identifiez la zone de la tendance sur laquelle vous voulez plus de détails.
	2. Identifiez la zone de la tendance sur laquelle vous voulez plus de détails.

	3. A l'aide de la souris, tracez un cadre autour de la zone en question en cliquant avec le bouto...
	3. A l'aide de la souris, tracez un cadre autour de la zone en question en cliquant avec le bouto...

	4. Le système fera un zoom avant sur la zone sélectionnée. Une barre de défilement horizontale ap...
	4. Le système fera un zoom avant sur la zone sélectionnée. Une barre de défilement horizontale ap...

	5. Si nécessaire, vous pouvez zoomer encore plus en utilisant la même technique.
	5. Si nécessaire, vous pouvez zoomer encore plus en utilisant la même technique.

	6. Pour quitter le mode Zoom et retourner au mode de sélection, cliquez à nouveau sur le bouton Z...
	6. Pour quitter le mode Zoom et retourner au mode de sélection, cliquez à nouveau sur le bouton Z...




	11.3.6 Zoom arrière vers la vue par défaut
	11.3.6 Zoom arrière vers la vue par défaut
	Vous pouvez effectuer un zoom arrière vers la vue par défaut de la façon suivante :
	Vous pouvez effectuer un zoom arrière vers la vue par défaut de la façon suivante :
	1. Cliquez sur le bouton droit de la souris n'importe où sur le graphe de tendance.
	1. Cliquez sur le bouton droit de la souris n'importe où sur le graphe de tendance.
	1. Cliquez sur le bouton droit de la souris n'importe où sur le graphe de tendance.
	Un menu déroulant apparaît.

	2. Sélectionnez l'option
	2. Sélectionnez l'option





	11.4 Tendance historique (tableau)
	11.4 Tendance historique (tableau)
	La fonction Historical Trending (Table) permet à l'utilisateur de visualiser des données de tenda...
	La fonction Historical Trending (Table) permet à l'utilisateur de visualiser des données de tenda...

	11.4.1 Lancer la tendance historique (tableau)
	11.4.1 Lancer la tendance historique (tableau)
	Cliquez sur le bouton Historical trending (Table) de la barre d'outils.
	Cliquez sur le bouton Historical trending (Table) de la barre d'outils.
	L'affichage Historical Trend (Table) est chargé. Il est chargé avec les dernières données complét...


	11.4.2 Configurer l'affichage de la tendance historique (tableau)
	11.4.2 Configurer l'affichage de la tendance historique (tableau)
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	1. Cliquez sur le bouton Edit trend data filter de la barre d'outils dans l'affichage de la tenda...
	Le module de filtre de la tendance historique est chargé.
	Voir l'illustration ci-dessous pour un exemple typique.
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	Le champ du serveur n'est visible que pour les systèmes redondants. Pour les systèmes redondants,...

	– Date/Time Start
	– Date/Time Start
	– Date/Time Start
	– Date/Time Start
	– Date/Time Start

	Il s'agit de la date/heure de départ pour laquelle les données de tendance historiques doivent êt...

	– Date/Time End
	– Date/Time End
	– Date/Time End

	Il s'agit de la date/heure de fin pour laquelle les données de tendance historiques doivent être ...

	– Fields
	– Fields
	– Fields

	Sélectionnez une cuve dans la liste déroulante. Sélectionnez les variables de process pour la cuv...

	– Values
	– Values
	– Values

	Sélectionnez le mode d'affichage des données :
	– Logged Values Only
	– Logged Values Only
	– Logged Values Only
	– Logged Values Only
	– Logged Values Only

	Etant donné que le dispositif d'enregistrement des tendances ne consigne que les modifications ap...

	– All Implied Values
	– All Implied Values
	– All Implied Values

	Si cette option est sélectionnée, toute variable de process qui n'a pas de valeur entrée dans l'e...

	– Interpolated Values
	– Interpolated Values
	– Interpolated Values

	Si cette option est sélectionnée, un enregistrement des données est généré pour chaque intervalle...







	2. Effectuez les réglages nécessaires et cliquez sur le bouton
	2. Effectuez les réglages nécessaires et cliquez sur le bouton
	L'affichage de tendance est configuré pour afficher les données requises.
	Le chargement des données historiques peut prendre un petit peu de temps. Cela dépendra de la lon...
	Voir l'illustration ci-dessous pour un exemple de données de tendance.
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	11.4.3 Exporter les données de tendance
	11.4.3 Exporter les données de tendance
	Le module Historical Trending (Table) est utilisé pour exporter les données de tendance sous form...
	Le module Historical Trending (Table) est utilisé pour exporter les données de tendance sous form...
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	Il s'agit en principe d'un dialogue de fichier Windows standard avec les champs supplémentaires s...
	Il s'agit en principe d'un dialogue de fichier Windows standard avec les champs supplémentaires s...
	•
	•
	Si cette option est sélectionnée, le premier enregistrement de données dans le fichier exporté co...

	•
	•
	Cette option contrôle le mode de formatage des données.
	– Formatted Data
	– Formatted Data
	– Formatted Data
	– Formatted Data
	– Formatted Data

	Exporter des données de tendance sous forme de données formatées signifie que le contenu du fichi...

	– Raw Data in Base Units
	– Raw Data in Base Units
	– Raw Data in Base Units

	Exporter les données de tendance sous forme de données brutes dans les unités de base signifie qu...

	– Raw Data
	– Raw Data
	– Raw Data

	Exporter des données de tendance sous forme de données brutes est identique à l'option précédente...









	12 Calculateur de stocks
	12 Calculateur de stocks
	Le système est équipé en standard d'un calculateur de stock.
	Le système est équipé en standard d'un calculateur de stock.
	L'objectif premier du calculateur de stock est de donner à l'utilisateur un moyen de calculer le ...
	Par exemple, il pourrait être utilisé comme un calculateur "que se passe-t-il si". Si une cuve do...
	Il peut être utilisé comme un simple outil de planification avant le chargement et/ou le décharge...

	12.1 Lancer l'application Inventory Calculator
	12.1 Lancer l'application Inventory Calculator
	Appuyez sur le bouton Inventory Calculator de la barre d'outils.
	Appuyez sur le bouton Inventory Calculator de la barre d'outils.
	Le module Inventory Calculator est chargé. Voir l'illustration ci-dessous pour un exemple typique...
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	12.2 Tank Calculator
	12.2 Tank Calculator
	Le Tank Calculator permet à l'utilisateur de calculer le stock en cuve à des conditions spécifiée...
	Le Tank Calculator permet à l'utilisateur de calculer le stock en cuve à des conditions spécifiée...

	12.2.1 Visualiser les données de cuve actuelles
	12.2.1 Visualiser les données de cuve actuelles
	Sélectionnez une cuve dans la liste déroulante.
	Sélectionnez une cuve dans la liste déroulante.
	Les données actuelles de tank gauging et de stock sont affichées pour la cuve sélectionnée avec l...


	12.2.2 Entrer les critères définis par l'utilisateur
	12.2.2 Entrer les critères définis par l'utilisateur
	L'utilisateur peut entrer les données suivantes :
	L'utilisateur peut entrer les données suivantes :
	L'utilisateur peut entrer les données suivantes :
	• Product Level
	• Product Level

	• Product Temperature
	• Product Temperature

	• Product Density
	• Product Density

	• Water Level
	• Water Level

	• Pressure
	• Pressure

	• Molecular Mass
	• Molecular Mass

	• Temperature Coefficient
	• Temperature Coefficient

	• Density Correction Factor
	• Density Correction Factor

	• API Table
	• API Table


	Certains champs de données ne sont pas toujours valables pour le tableau API sélectionné.
	Les champs pouvant être édités sont clairement marqués sur l'affichage en fond blanc.

	La procédure
	La procédure
	Pour calculer les données, procédez de la façon suivante :
	Pour calculer les données, procédez de la façon suivante :
	Pour calculer les données, procédez de la façon suivante :
	1. Modifiez l'un des champs éditables.
	1. Modifiez l'un des champs éditables.

	2. Appuyez sur le bouton
	2. Appuyez sur le bouton
	Les paramètres de stock sont recalculés pour les nouvelles données.

	Les données configurables par l'utilisateur sont validées avant d'effectuer les calculs.
	Par exemple, si le niveau dépasse la plage de service de la cuve, un avertissement est généré dan...



	Exemple
	Exemple
	Par exemple, pour visualiser le stock en cuve à un niveau de produit différent, effacez simplemen...
	Par exemple, pour visualiser le stock en cuve à un niveau de produit différent, effacez simplemen...




	12.3 Movement Calculator
	12.3 Movement Calculator
	Le Movement Calculator permet à l'utilisateur de simuler un chargement ou un déchargement de prod...
	Le Movement Calculator permet à l'utilisateur de simuler un chargement ou un déchargement de prod...
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	1. Avant d'entrer les détails du mouvement, sélectionnez une cuve dans la liste. Les conditions a...
	1. Avant d'entrer les détails du mouvement, sélectionnez une cuve dans la liste. Les conditions a...
	1. Avant d'entrer les détails du mouvement, sélectionnez une cuve dans la liste. Les conditions a...

	2. Spécifiez le mouvement comme :
	2. Spécifiez le mouvement comme :

	3. Spécifiez s'il s'agit d'un déchargement (mouvement out) ou d'un chargement (mouvement in) pour...
	3. Spécifiez s'il s'agit d'un déchargement (mouvement out) ou d'un chargement (mouvement in) pour...

	4. Entrez la quantité à décharger ou à charger.
	4. Entrez la quantité à décharger ou à charger.

	5. Par ailleurs, vous pouvez activer jusqu'à quatre
	5. Par ailleurs, vous pouvez activer jusqu'à quatre

	6. Appuyez sur le bouton
	6. Appuyez sur le bouton

	7. Vous pouvez sauvegarder les données calculées dans la base de données en cliquant sur le bouton
	7. Vous pouvez sauvegarder les données calculées dans la base de données en cliquant sur le bouton
	Cela détermine le niveau de mouvement final de sorte que le système de tank gauging puisse calcul...

	8. Les calculs peuvent être effacés en cliquant sur le bouton
	8. Les calculs peuvent être effacés en cliquant sur le bouton



	12.3.1 Exemple : Simuler un chargement de produit
	12.3.1 Exemple : Simuler un chargement de produit
	1. Sélectionnez la cuve réceptrice dans la liste.
	1. Sélectionnez la cuve réceptrice dans la liste.
	1. Sélectionnez la cuve réceptrice dans la liste.
	1. Sélectionnez la cuve réceptrice dans la liste.

	2. Cliquez sur bouton
	2. Cliquez sur bouton

	3. Sélectionnez l'option appropriée pour
	3. Sélectionnez l'option appropriée pour
	Par exemple, supposons que nous allons recevoir un volume connu d'un pipeline. Sélectionnez l'option

	4. Entrez la
	4. Entrez la
	Les unités utilisées pour le volume sont celles définies dans le module Change Dimensions.
	Supposons que les unités de volume réglées sont les litres.

	5. Activez les préalarmes cibles et entrez l'offset du niveau final auquel elles doivent se décle...
	5. Activez les préalarmes cibles et entrez l'offset du niveau final auquel elles doivent se décle...

	6. Appuyez sur le bouton
	6. Appuyez sur le bouton



	Résultat
	Résultat
	• L'Inventory Calculator va aux données de Tank Calibration pour la cuve sélectionnée et détermin...
	• L'Inventory Calculator va aux données de Tank Calibration pour la cuve sélectionnée et détermin...
	• L'Inventory Calculator va aux données de Tank Calibration pour la cuve sélectionnée et détermin...
	• L'Inventory Calculator va aux données de Tank Calibration pour la cuve sélectionnée et détermin...

	• Par conséquent, le niveau calculé et les données de stock seront les conditions attendues une f...
	• Par conséquent, le niveau calculé et les données de stock seront les conditions attendues une f...

	• Le calcul des conditions finales est vérifié par rapport aux limites de fonctionnement de la cu...
	• Le calcul des conditions finales est vérifié par rapport aux limites de fonctionnement de la cu...

	• Pour toutes les préalarmes activées, la consigne de niveau absolu à laquelle l'alarme se déclen...
	• Pour toutes les préalarmes activées, la consigne de niveau absolu à laquelle l'alarme se déclen...






	12.4 Interpolation
	12.4 Interpolation
	L'onglet Interpolation est un outil très simple de calcul d'interpolation linéaire. Il permet à l...
	L'onglet Interpolation est un outil très simple de calcul d'interpolation linéaire. Il permet à l...
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	12.5 Conversion des unités
	12.5 Conversion des unités
	L'onglet Unit Conversion contient un outil simple permettant de convertir une valeur dans une uni...
	L'onglet Unit Conversion contient un outil simple permettant de convertir une valeur dans une uni...
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	13 Scan Controller
	13 Scan Controller
	L'état d'interrogation des jaugeurs peut être réglé à l'aide de l'outil Scan Controller. Pour acc...
	L'état d'interrogation des jaugeurs peut être réglé à l'aide de l'outil Scan Controller. Pour acc...
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	Les détails de tous les jaugeurs configurés dans la base de données sont affichés avec l'état d'i...
	A partir de cette page, il est possible de régler l'état d'interrogation d'un ou plusieurs jaugeurs.

	Sélectionner les jaugeurs
	Sélectionner les jaugeurs
	Sélectionner les jaugeurs
	Sélectionner les jaugeurs
	• Pour sélectionner un jaugeur, cliquez dessus dans le tableau.
	• Pour sélectionner un jaugeur, cliquez dessus dans le tableau.
	• Pour sélectionner un jaugeur, cliquez dessus dans le tableau.
	• Pour sélectionner un jaugeur, cliquez dessus dans le tableau.

	• Pour sélectionnez plusieurs jaugeurs, maintenez la touche
	• Pour sélectionnez plusieurs jaugeurs, maintenez la touche

	• En alternative, cliquez sur le bouton
	• En alternative, cliquez sur le bouton




	Régler l'état d'interrogation
	Régler l'état d'interrogation
	Pour régler l'état d'interrogation, cliquez sur l'un des boutons en haut de l'écran.
	Pour régler l'état d'interrogation, cliquez sur l'un des boutons en haut de l'écran.
	• Set Normal Scan
	• Set Normal Scan
	• Set Normal Scan
	• Set Normal Scan

	Met tous les jaugeurs sélectionnés en état d'interrogation normal.

	• Set Fast Scan
	• Set Fast Scan
	• Set Fast Scan

	Met tous les jaugeurs sélectionnés en état d'interrogation rapide. La vitesse d'interrogation rap...

	• Set Off Scan
	• Set Off Scan
	• Set Off Scan

	Arrête l'interrogation pour tous les jaugeurs sélectionnés. Cela affecte toutes les Datacons conn...

	• Set Manual Scan
	• Set Manual Scan
	• Set Manual Scan

	Met tous les jaugeurs sélectionnés en état d'interrogation manuel. Les jaugeurs ne sont interrogé...

	• Set Offline
	• Set Offline
	• Set Offline

	Met tous les jaugeurs sélectionnés en mode Offline dans les communications DCC. Cela affecte uniq...


	L'état d'interrogation de tous les jaugeurs est automatiquement actualisé dans l'affichage Scan C...





	<GRAPHIC>
	<GRAPHIC>
	<GRAPHIC>
	<GRAPHIC>


	BA
	BA
	BA
	00396
	G
	14
	FR
	13.10

	FM+SGML 6.0/ProMoDo
	FM+SGML 6.0/ProMoDo

	<GRAPHIC>
	<GRAPHIC>






<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (None)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /UseDeviceIndependentColor
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments false
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo false
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Preserve
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
    /ArialMT
    /Glypha-Bold
    /Wingdings-Regular
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages false
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth 8
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /FlateEncode
  /AutoFilterColorImages false
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages false
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth 8
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /FlateEncode
  /AutoFilterGrayImages false
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.40
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages false
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 300
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<
    /ENU ()
  >>
>> setdistillerparams
<<
  /HWResolution [1200 1200]
  /PageSize [651.935 907.040]
>> setpagedevice


